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Note:

The contents of the Guest Operating System Installation Guide have changed. The new version of this
guide contains only information and instructions applicable to installing guest operating systems.
For guest operating system support data, see the new Guest/Host OS VMware Compatibility Guide.
For VMware Tools information, see the applicable product documentation on the VMware
Documentation Web site http://www.vmware.com/support/pubs/.

For known issues, see the VMware Knowledge Base located at http://kb.vmware.com/.

The deprecated Guest Operating System Installation Guide, the new version of the Guest Operating
System Installation Guide, and the new Guest/Host OS VMware Compatibility Guide are all located at
http://www.vmware.com/resources/compatibility/search.php?deviceCategory=software.
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You can find the most up-to-date technical documentation on the VMware Web site at:
http://www.vmware.com/support/

The VMware Web site also provides the latest product updates.

If you have comments about this documentation, submit your feedback to:

docfeedback@vmware.com
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About This Book

The Guest Operating System Installation Guide provides users of VMware® ESX Server, VMware GSX Server,
VMware Server, VMware ACE, VMware Workstation, and VMware Fusion™ information about installing
guest operating systems in VMware virtual machines.

Revision History

This guide is revised with each newly supported guest operating system that requires installation instructions.

Table 1. Revision History
Revision Description

20090902 m  Revised install instructions for MS-DOS 2.66 and MS-DOS 3.1x.

Modified instal instructions for SUSE Linux Enterprise Server 10 and 9 to use the GRUB
BootLoader instead of LILO.

B Made minor edits to information for SUSE Linux Enterprise Server 10.

20090716 ®m  Reorganized the Guest Operating System Installation Guide to include information only
pertinent to installing supported guest operating systems. To find the information and
support data that was removed from this guide check these locations:

B Guest Operating System Installation Guide (Deprecated) — for information that was
published in the guide prior to July 16, 2009.

®  Online Guest/Host OS VMware Compatibility Guide — for supported guest
operating system details and general information.

®  Knowledge Base — for known issues and problems that affected the operation of a
guest.

®  Product documentation - for VMware Tools instructions and information.

Intended Audience

This book is intended for anyone interested in the operating systems supported by VMware products, their
installation instructions, and known issues.

Document Feedback

VMware welcomes your suggestions for improving our documentation. If you have comments, send your
feedback to docfeedback@vmware.com.

Technical Support and Education Resources

The following sections describe the technical support resources available to you. To access the current version
of this book and other books, go to http://www.vmware.com/support/pubs.
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Online and Telephone Support

To use online support to submit technical support requests, view your product and contract information, and
register your products, go to http://www.vmware.com/support.

Customers with appropriate support contracts should use telephone support for the fastest response on
priority 1 issues. Go to http://www.vmware.com/support/phone_support.html.
Support Offerings

To find out how VMware support offerings can help meet your business needs, go to
http://www.vmware.com/support/services.

VMware Professional Services

VMware Education Services courses offer extensive hands-on labs, case study examples, and course materials
designed to be used as on-the-job reference tools. Courses are available onsite, in the classroom, and live
online. For onsite pilot programs and implementation best practices, VMware Consulting Services provides
offerings to help you assess, plan, build, and manage your virtual environment. To access information about
education classes, certification programs, and consulting services, go to http://www.vmware.com/services.
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Installing Guest Operating
Systems

The Guest Operating System Installation Guide includes installation instructions for installing supported guest
operating systems on the following VMware products:

® VMware ESX Server 2.0 and later
B VMware ESXi/ESX 3.5 and later

®  VMware Workstation 4.0 and later
B VMware Server 1.0 and later

®  VMware Fusionl1.0 and later

®  VMware ACE 1.0 and later

® VMware GSX Server 3.0 and later

If you are using VMware® Workstation 3.x, VMware GSX Server 2.x, VMware ESX Server 1.x or an earlier
VMware product, see the user’s manual that came with your product for instructions on installing guest
operating systems supported by that product.

Operating systems that are not included in this guide are not supported.

See “General Installation Instructions for All VMware Products” on page 14 for information that might apply
to the guest you are installing and see “Latest Updates” on page 13 for the most recent changes to this guide.

Latest Updates

Find the latest version of the guide on the VMware Web site at: http://www.vmware.com/support/pubs. Check
the date on the cover page to determine if your copy of the guide is the most current. These are the changes or
updates made to the Guest Operating System Installation Guide since it was last published.

B Revised install instructions for MS-DOS 2.66 and MS-DOS 3.1x. See “MS-DOS 6.22 and Windows 3.1x” on
page 30.

B Modified instal instructions for SUSE Linux Enterprise Server 10 and 9 to use the GRUB BootLoader
instead of LILO. See “SUSE Linux Enterprise Server 10” on page 91 and “SUSE Linux Enterprise Server
9” on page 92.

B Made minor edits to information for SUSE Linux Enterprise Server 10. See “SUSE Linux Enterprise Server
10” on page 91.

VMware, Inc. 13
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General Guidelines for Supported Guests

A variety of configurations, support, and hardware might influence how you install a supported guest
operating system.

Determining Memory Settings for a Virtual Machine

When you configure the memory settings for a virtual machine, you should consult the documentation for the
guest operating system you plan to run in that virtual machine. The user interface of your VMware product
provides general guidelines for the amount of memory required, but if the interface and the operating system
documentation do not agree, you should rely on the operating system documentation.

Sound Adapters on GSX and VMware Servers

Sound adapters by default are not installed in a virtual machine for GSX or VMware Servers. To add a sound
adapter, use the virtual machine settings editor (VM > Settings) after you have installed the operating system.
For instructions on configuring sound for a virtual machine on a G5X or VMware Server, see the
corresponding server documentation.

Running a Guest Operating System

For information on running a guest operating system and using its features, see the documentation provided
by the operating system vendor.

64-Bit Linux Guests and Execute Disable Functionality

When running a 64-bit Linux guest operating system on EM64T hardware, make sure that you have Execute
Disable functionality enabled in the host BIOS. This helps to ensure that the Linux guest operating system will
run without interruption.

General Installation Instructions for All VMware Products

Before installing a guest operating system, create a virtual machine and ensure that its devices are set up as
you expect. For example, if you would like networking software to be installed when you install the guest
operating system, be sure the Ethernet adapter is configured and enabled for the virtual machine.

The tool or interface you use to configure the virtual machine depends on the VMware product you are using.

A new virtual machine is like a physical computer with a blank hard disk. Before you can use it, you must
partition and format the virtual disk and install an operating system. The operating system installation
program might handle the partitioning and formatting steps for you.

NOTE You should disable any screen saver that might be running on the host system before you start to install
the guest operating system.

Installing a guest operating system inside a virtual machine is essentially the same as installing it on a physical
computer.

Typical Installation
The basic steps to install a typical operating system:
1  Start your VMware product and connect to the virtual machine.

2 Insert the installation CD-ROM or disc for your guest operating system into the CD-ROM or disc drive
being used by the virtual machine.

ESX Server 2.x: You must insert the installation CD-ROM or disc in the drive on the server where the
virtual machine is running. You cannot use the drives on the management workstation.

14 VMware, Inc.



Installing Guest Operating Systems

GSX Server: If your guest operating system requires a disc, you must insert it in the drive on the server
where the virtual machine is running. You cannot use the disc drive on the management workstation.

3 Power on your virtual machine by clicking the Power On button.
4  Follow the instructions provided by the operating system vendor.

As with physical computers, a separate operating system license is required for each virtual machine you run.

NOTE Some Microsoft Windows OEM discs included with new computers are customized for those
computers and include device drivers and other utilities specific to the hardware system. Even if you can
install this Windows operating system on your physical computer, you might not be able to install it in a
virtual machine. You might need to purchase a new copy of Windows to install in a virtual machine.

ISO Installation

Rather than boot from a physical CD-ROM, you can create an ISO image file from the installation CD-ROM.
You can store the ISO file on the host machine or on a network drive accessible from the host machine. Use the
configuration tool for your VMware product to connect the virtual machine CD drive to the ISO image file,
and then power on the virtual machine.

Using an ISO image file is convenient if you need to install the same operating system in multiple virtual
machines. It can also help you work around a problem seen in some host configurations, in which the virtual
machine is not able to boot from the installation CD-ROM.

PXE Installation

If you plan to use a PXE server to install the guest operating system over a network connection, you do not
need the operating system installation media. When you power on the virtual machine, the virtual machine
detects the PXE server.

VMware, Inc. 15
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Windows 7

Read “General Guidelines for Supported Guests” on page 14 and this section before installing this operating
system.

Install Windows 7 in a virtual machine using the corresponding Windows 7 distribution CD. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 7:
B Create and configure a new virtual machine.

B Make sure the virtual machine has at least 1GB of RAM or more for 32-bit guests and 2GB or more of RAM
for 64-bit guests.

®  For the 32-bit version of Windows 7, the hard drive for the virtual machine must be 24GB or larger.

B For the 64-bit version of Windows 7, the hard drive for the virtual machine must be 32GB or larger.

Installation Steps
1 Insert the Windows 7 CD or DVD in the CD-ROM drive.
2 Power on the virtual machine to start installing Windows 7.

3 Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Windows Preinstallation Environment

Read “General Installation Instructions for All VMware Products” on page 14 and this section before installing
this operating system.

Fulfill these prerequisites before installing Windows Preinstallation Environment:

Create and configure a new virtual machine.
Select Windows Vista for the guest operating system selection. A Windows PE selection is not available.

Download Windows AIK 1.1 (WAIK1.1) software (build from Windows Server 2008 kernel) from the
Microsoft Web site:

http://www.microsoft.com/downloads/details.aspx?familyid=94BB6E34-D890-4932-81 A5-5B50C657DEQ
8&displaylang=en

Create a Windows PE 2.1 ISO image.

To create a Windows PE 2.1 ISO image

1
2

Create a Windows 2008 virtual machine, and install WAIK 1.1.

Select Start > All Programs > Microsoft Windows AIK > Windows PE Tools Command Prompt to open
the Windows PE Tools Command Prompt.

Type one of the following commands to create a Windows PE build environment for an x86 or amd64
machine in the winpe-x86 folder.

Platform Command
32-bit copype x86 C:\Winpe-x86
64-bit copype amd64 C:\Winpe-amd64

Create a Windows PE 2.1 bootable ISO image by entering the following command:

oscdimg -n —-h -bc:\winpe-x86\etfsboot.com c:\winpe-x86\iso c:\winpe-x86\winpe-x86.1iso

Installation Steps

1
2

Boot the virtual machine from a Windows PE 2.1 ISO image.
After the boot process completes, a command prompt appears.

Use Windows PE to prepare your virtual machine to install a Windows operating system.

VMware Tools

There is no version of VMware Tools that supports Windows Preinstallation Environment.

VMware, Inc.
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Windows Recovery Environment

Read “General Installation Instructions for All VMware Products” on page 14 and this section before installing
this operating system.

For instructions specific to the Windows Recovery Environment, see the accompanying operating system
documentation.

VMware Tools

There is no version of VMware Tools that supports Windows Recovery Environment.
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Windows Server 2008

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install the Windows Server 2008 in a virtual machine using the Windows Server 2008 distribution CD.
If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Server 2008:

Create and configure a new virtual machine.

Ensure that the virtual machine has at least 512MB of RAM. The host computer must have more than
512MB of RAM to support this setting.

For the 32-bit version of Windows Server 2008, the hard drive for the virtual machine must be 16GB or
larger.

For the 64-bit version of Windows Server 2008, the hard drive for the virtual machine must be 24GB or
larger.

Consider these support and configuration issues for Windows Server 2008:

If an Internet connection is not available while installing a 32-bit Windows Server 2008 guest, the driver
for the multimedia audio controller will not be installed. The Windows Device Manager will indicate that
the driver for the multimedia audio controller is missing. To install the required driver, configure an
Internet connection, and run Windows Update on the Windows Server 2008 virtual machine.

The Server Core role available in the Standard, Datacenter, and Enterprise editions of Windows 2008

Server is supported by ESX. VMware Tools still apply, unless Server Core disables parts of the operating
system that are specifically supported by VMware Tools. See the Microsoft Developer Network Web site
for more information about Server Core: http://msdn.microsoft.com/en-us/library/ms723891(VS.85).aspx

Installation Steps

1
2
3

Insert the Windows Server 2008 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows Server 2008.

Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

VMware, Inc.
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Windows Vista

20

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows Vista in a virtual machine using the corresponding Windows Vista distribution CD.
If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Vista:
B Create and configure a new virtual machine.

B Make sure the virtual machine has at least 512MB of RAM. The host computer must have more than
512MB of RAM to support this setting.

®  For the 32-bit version of Windows Vista, the hard drive for the virtual machine must be 16GB or larger.
®  For the 64-bit version of Windows Vista, the hard drive for the virtual machine must be 24GB or larger.
Consider these support and configuration issues for Windows Vista:

®  If an Internet connection is not available while installing a 32-bit Windows Vista guest, the driver for the
multimedia audio controller will not be installed. The Windows Device Manager will indicate that the
driver for the multimedia audio controller is missing. To install the required driver, configure an Internet
connection, and run Windows Update on the Windows Vista virtual machine.

Installation Steps
1 Insert the Windows Vista CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Windows Vista.

3  Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE After installing VMware Tools on a Windows Vista Service Pack (SP1) virtual machine, the screen
resolution does not change to 1024 by 768 pixels automatically. See knowledge base article 1004780 at
http://kb.vmware.com/kb/1004780.
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Windows Server 2003

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows Server 2003 in a virtual machine using the corresponding Windows Server 2003
distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Server 2003:

Create and configure a new virtual machine.

Consider these support and configuration issues for Windows Server 2003:

If an Internet connection is not available while installing a Windows Server 2003 guest, the driver for the
multimedia audio controller will not be installed. The Windows Device Manager will indicate that the
driver for the multimedia audio controller is missing. To install the required driver, configure an Internet
connection, and run Windows Update on the Windows Server 2003 virtual machine.

If you are using the virtual LSI Logic SCSI adapter, Windows Server 2003 automatically installs the SCSI
driver when you install the guest operating system. If you are using the virtual BusLogic SCSI adapter,
you need a special SCSI driver available from the download section of the VMware Web site at
www.vmware.com/download. Follow the instructions on the Web site to use the driver with a fresh
installation of Windows Server 2003.

If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system and
want to upgrade it to Windows Server 2003, install the new SCSI driver before upgrading the operating
system.

You need to manually configure the e1000 network adapter driver in ESX 3.0.2 to support Windows Server
2003 Datacenter Edition. Refer to knowledge base article 1003020 at http://kb.vmware.com/kb/1003020.

Installation Steps

1
2
3

Insert the Windows Server 2003 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows Server 2003.

If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site, you must take
some special steps at this point in the installation process.

As the Windows Server 2003 installer loads, press the F6 key.

This allows you to select the additional SCSI driver required for installation.
Press S to specify the additional driver.

After you specify the SCSI driver, press Enter to continue with setup.

Follow the remaining installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

VMware, Inc.
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Windows XP

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows XP Home Edition or Professional in a virtual machine using the corresponding

Windows XP distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows XP:

Create and configure a new virtual machine

Consider these support and configuration issues for Windows XP:

ESX, VMware Workstation, VMware ACE, and GSX Server: To use the virtual BusLogic SCSI adapter in
a Windows XP virtual machine, you need a special SCSI driver available from the download section of the
VMware Web site at www.vmware.com/download. Follow the instructions on the Web site to use the
driver with a fresh installation of Windows XP.

ESX and GSX Server: If you are using the virtual LSI Logic SCSI adapter in a Windows XP virtual
machine, download the driver from the download center at the LSI Logic Web site. Go to
http://www.lsi.com/cm/DownloadSearch.do?locale=EN and download the LSI20320-R SCSI adapter
driver for your guest operating system.

The LSI Logic Web site also provides a guide for installing the drivers. Go to http://www.lsi.com/. Select
Support & Downloads > Documentation. Enter the search term Fusion MPT to find the Fusion-MPT
Device Management User Guide.

ESX: You can also use the vimscsi SCSI driver for the virtual BusLogic SCSI adapter provided on the floppy
image that is included with the ESX software.

If you have a virtual machine with a SCSI virtual disk and an earlier Windows guest operating system and
want to upgrade it to Windows XD, install the new SCSI driver before upgrading the operating system.

Installation Steps

1
2

Insert the installation CD in the CD-ROM drive.
Power on the virtual machine to start installing the guest operating system.

If you are using the virtual BusLogic SCSI driver downloaded from the VMware Web site or the LSI Logic
SCSI driver downloaded from the LSI Logic Web site, you must take some special steps at this point in the
installation process.

As the Windows XP installer loads, press the F6 key.
This allows you to select the additional SCSI driver required for installation.
Press S to specify the additional driver, and press Enter to continue with the setup.

Follow the installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Windows 2000

Be sure to read“General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install a supported version of Windows 2000 in a virtual machine using the corresponding Windows
2000 distribution CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 2000:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Windows 2000:

m  ESX Server, VirtualCenter, or vCenter Server: If you are using the virtual LSI Logic SCSI adapter, you
must download the driver from the download center at the LSI Logic Web site. Go to
http://www.lsi.com/cm/DownloadSearch.do?locale=EN and download the LSI20320-R SCSI adapter
driver for your guest operating system.

Installation Steps
1  Insert the Windows 2000 CD in the CD-ROM drive.

2 Power on the virtual machine to start installing Windows 2000.

3 Follow the installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you install VMware Tools, change the Windows 2000 screen area to be greater than 640x480 pixels; if you
do not change it, Windows 2000 uses the standard VGA driver, and performance will suffer.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows NT 4.0 (Workstation or Server) in a virtual machine using the standard Windows NT
CD. If your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows NT 4.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Windows NT 4.0:

®  To set up a virtual machine running Windows NT 4.0 and using multiple disks, you must first create a
virtual machine with only one disk. Install Windows NT on that disk. Then use the configuration tools in
your VMware product to add the additional disks.

®  Ifyouhave a Windows NT 4.0 guest with a SCSI virtual disk, you cannot add both an additional SCSI disk
and an IDE disk to the configuration.

®  If you intend to run a Windows NT virtual machine with IDE virtual disks on a multiprocessor host
computer, you might notice slower than expected disk input/output performance. For more information,
see Disk Performance in Windows NT Guests on Multiprocessor Hosts in the GSX Server documentation.

Installation Steps

1 Insert the Windows NT 4.0 CD in the CD-ROM drive.
Power on the virtual machine to start installing Windows NT 4.0.

Follow the installation steps as you would for a physical machine.

= W DN

Virtual disks support DMA transfers for better performance.

You can enable the feature after installing Windows NT 4.0. You need the NT Service Pack 3 or 4 CD to
enable this option. Once the virtual machine is running Windows NT, insert the SP3 or SP4 CD in the
drive, run DMACHECK . EXE from the \SUPPORT\UTILS\I386 folder on the CD and click the Enabled option
for the IDE controller/channel that is configured with the virtual disk (typically channel 0 only, unless you
have the virtual machine configured with multiple virtual disks).

NOTE The DMA option should not be enabled for any IDE channel that has a CD-ROM drive configured
for it. Enabling DMA for such a configuration causes an error. If you have a virtual disk and a CD-ROM
attached as master and slave to the primary IDE controller (channel 0) and you want to enable DMA,
power off the virtual machine and use the Configuration Editor to move the CD-ROM to the secondary
IDE controller (channel 1) at IDE 1:0. Then boot the virtual machine with Windows NT, run DMACHECK and
enable DMA for channel 0 only.

DMA is always enabled on SCSI virtual disks.

Post Installation Instructions

Enabling Networking After Installing Windows NT 4.0

If networking was disabled at the time you installed Windows NT, you can enable it after installing the
operating system. Shut down Windows NT and power off the virtual machine. Add the network adapter to
the virtual machine’s configuration, and then follow the instructions below to install the network driver in the
Windows NT guest operating system.

1  Power on the virtual machine.

2 While Windows NT is booting, insert the Windows NT 4.0 CD in the CD-ROM drive.
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3  Log on to Windows NT and install the AMD PCNET driver:

a  Open the Network properties page by double-clicking the Network icon in Control Panel. Change to
the Network Adapters screen by clicking the Adapters tab.

b  Click the Add button and select the AMD PCNET Family Ethernet Adapter from the list.

¢ A message pops up prompting you to enter a path for the Windows NT files. Specify the \1386 folder
on the CD in the path you enter (for example, type D:\1386 if the CD is in drive D) and click
Continue.

d  Windows NT setup prompts you for the Windows NT files again. Click Continue.

e  Use the default adapter settings; they do not need to be changed. Windows NT setup prompts you
again for a path to the Windows NT files. Click Continue to finish installing the driver.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE To view VMware Tools online help in a Windows NT 4.0 guest, Windows NT 4.0 must have Internet
Explorer 4.0 or greater installed.
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Windows Me

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows Millennium Edition in a virtual machine using the standard Windows Me CD. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows Me:

B Create and configure a new virtual machine.

Installation Steps
1 Insert the Windows Me CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Windows Me.

3 Choose to boot from CD-ROM, and then select the option Start Windows Me Setup from CD-ROM. The
setup program runs FDISK and reboots.

4 Once again, choose to boot from CD-ROM, and then select the option Start Windows Me Setup from
CD-ROM. The setup program continues installing Windows Me.

5 Follow the Windows Me installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

26 VMware, Inc.


http://kb.vmware.com/kb/340

Installing Guest Operating Systems

Windows 98

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install Windows 98 in a virtual machine using the standard Windows 98 CD. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Windows 98:

B Create and configure a new virtual machine.

Installation Steps
1 Insert the Windows 98 CD in the CD-ROM drive.

NOTE Some Windows 98 packages require that you boot from a floppy disk. If you have such a package,
insert the boot floppy in the floppy disk drive. Follow the on-screen instructions. Be sure to run FDISK
and FORMAT when the installer prompts you to do so.

2 Power on the virtual machine to start installing Windows 98.

3 Choose to boot from CD-ROM, and then select the option Start Windows 98 Setup from CD-ROM. The
setup program runs FDISK and reboots.

4 Once again, choose to boot from CD-ROM, and then select the option Start Windows 98 Setup from
CD-ROM. The setup program continues installing Windows 98.

5 Follow the Windows 98 installation steps as you would for a physical PC.

Post Installation Instructions

Enabling Networking After Installing Windows 98

If networking was disabled at the time you installed Windows 98, you can enable it after the operating system
has been installed. To set up networking for a virtual machine, power off the virtual machine and add a
network adapter to the configuration. When you power on the virtual machine, Windows 98 automatically
detects an AMD PCNET Family Ethernet Adapter (PCI-ISA) and prompts for the Windows 98 CD-ROM to
install drivers. The default Ethernet adapter settings should work well and do not need to be changed. Use the
Network icon in the Windows 98 Control Panel to view or change network settings. For example, you might
want to add the TCP/IP protocol since Windows 98 does not install it by default.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Windows 95

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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You can install Windows 95 in a virtual machine using a standard Windows 95 boot floppy and CD-ROM. If
your VMware product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Window95:

Create and configure a new virtual machine.

Consider these support and configuration issues for Windows 95:

You must FDISK and FORMAT the virtual hard disk drives before running Windows 95 setup. (Some
Windows 95 distributions provide instructions that do not include the steps to FDISK and FORMAT a C:
drive.)

The installation instructions are for the simplest case of one virtual IDE hard drive and one virtual IDE
CD-ROM drive. If you have configured the virtual machine with more than one IDE hard drive, you
should also FDISK and FORMAT these drives before installing Windows 95. If you have configured the
virtual machine with more than one virtual hard drive or more than one virtual CD-ROM, you might need
to use device letters that are different from those in the instructions below.

Installation Steps

1

Insert the Windows 95 CD-ROM Setup Boot Disk in floppy drive A: used by your virtual machine and
insert the Windows 95 CD in the CD-ROM drive.

Power on the virtual machine to start installing Windows 95.

After the virtual machine boots, if you are presented with a choice of CD-ROM drivers, select the first IDE
driver option available (even if your computer has a SCSI CD-ROM drive).

Partition the virtual disk.
A:\> FDISK

Answer the questions.

NOTE If you create a primary partition that is smaller than the full size of the virtual disk, be sure the
partition is marked active.

Reboot Windows 95. If the cursor is not already within the virtual machine window, click in the virtual
machine display, and then press Ctrl+Alt+Ins on a Windows host or Ctrl+Alt+Del on a Linux host. If
prompted on reboot to select a CD-ROM driver, select the first IDE CD-ROM driver from the list.

Format the C: drive.
A:\> FORMAT C: /S
Start the Windows 95 installation.

A:\> D:\WIN95\SETUP /IS

An intermittent problem can occur during Windows 95 installations in a virtual machine. Shortly after the
Windows 95 Setup program is started, Scandisk runs to completion, and when the Windows 95 Setup
program should start its graphical user interface, the virtual machine returns to an MS-DOS prompt.
VMware recommends you reboot the virtual machine and rerun Windows 95 Setup. You do not need to
FDISK or FORMAT the drive again. If this problem occurs reproducibly, please report it to VMware technical
support.
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8  If the virtual machine’s Ethernet adapter is enabled, you have to manually add an Ethernet driver because
Windows 95 does not detect it during the Analyzing Computer phase (even if you selected the Network
Adapter detection option). Do the following to enable networking;:

a  Continue with the Windows 95 installation until you get to the Windows 95 Setup Wizard/Setup
Options screen. Change the default setting from Typical to Custom and click Next to continue.

b From the Network Configuration screen (which appears after the Analyzing Computer phase), click
Add, select the Adapter component, select Advanced Micro Devices from the manufacturer window
and AMD PCNET Family Ethernet Adapter (PCI&ISA) from the network adapter window.

¢ If you need TCP/IP networking, add it from the Network Configuration screen (Windows 95 Setup
does not enable TCP/IP by default). If you don’t do this, the first phase of the Windows 95 installation
does not copy some of the files it will need later, and the entire installation fails.

Also be sure that the Microsoft NetBEUI protocol is installed. It might not be installed by default.
9  Finish the Windows 95 installation.

10 VMware virtual disks support DMA transfers for better performance. The feature can be enabled after
you have installed Windows 95 on a virtual IDE disk. Follow these steps to enable the feature:

a  Right-click My Computer and select Properties.

b From the System Properties dialog box, click the Device Manager tab.
¢ Double-click the Disk Drives device category.

d Double-click the GENERIC IDE DISK TYPEOQ1 device.

e  Click the Settings tab and select the DMA check box.

Post Installation Instructions

Enabling Networking After Installing Windows 95

If networking was disabled at the time you installed Windows 95, you can enable it after installing the
operating system. Shut down Windows 95 and power off the virtual machine. Add the network adapter to the
virtual machine’s configuration, and then follow the instructions below to install the network driver in the
Windows 95 guest operating system.

1  Power on the virtual machine.

2 When Windows 95 reboots, it auto-detects an AMD PCNET Family Ethernet Adapter (PCI&ISA) and
prompts for the Windows 95 CD-ROM to install drivers. The default Ethernet adapter settings should
work fine and do not need to be changed.

3 Double-click the Network icon in the Control Panel to view or change network settings. For example, you
might want to add the TCP/IP protocol since Windows 95 does not install it by default.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

Requirements for installing MS-DOS 6.22 and Windows 3.1.x:

B A new configured virtual machine.

m  Full version of the Microsoft MS-DOS 6.22 installation disks.
B Windows 3.1x standard installation disks.

®  CD-ROM drivers — by default the OAKCDROM. sys driver is provided with MS-DOS startup disks. You can
also use other drivers that are available to you, for example AOATAPI.SYS, or else you can download
drivers from the web. These drivers are typically loaded at system startup by making a series of entries in
the C:\CONFIG.SYS and C:\AUTOEXEC.BAT machine files.

MS-DOS 6.22 and Windows 3.1x Installation

You can install MS-DOS 6.22 inside a virtual machine using the Microsoft full-version MS-DOS 6.22
installation disks. If you have the upgrade disks, you must install an earlier version of MS-DOS 6.22 before you
upgrade.

NOTE The HIMEM. SYS file is included with MS-DOS and enables upper memory for MSCDEX. EXE.

VMware Workstation, VMware ACE, and GSX Server virtual machines support the networking features found
in Windows 3.11 (or Windows for Workgroups). After installation, select the Advanced Micro Devices
PCNET Family (NDIS2/NDIS3) Ethernet driver for the networking option.

The following articles provide information for configuring networking in a DOS 6.22 and Win 3.1x
environment:

B Load DOS Network drivers in virtual machine — http://communities.vmware.com/message/109168

®  Create a VMware Workstation Network Boot Disk — http://communities.vmware.com/message/38060
To install MS-DOS 6.22

1 Insert the MS-DOS disk into the disk drive.

2 Power on the virtual machine and begin installing MS-DOS.

3 After the installation is complete, reboot the guest.

The command prompt appears.

To complete the MS-DOS installation

1  Verify that the following files are installed in the root directory of the boot device:
MSCDEX. EXE, AUTOEXEC. BAT, and CONFIG.SYS filein C:\

2 Copy the OAKCDROM. SYS CD-ROM driver file to a disk.

3 Insert the disk with the driver file in the disk drive and connect it to the guest from the VM > Settings
menu.

4  From the command prompt, copy the contents from drive A to drive C.
A:\OAKCDROM. SYS C:DOS\

5  Open and edit the MS-DOS AUTOEXEC. BAT file. Add the following line:
LH C:\DOS\MSCDEX.EXE /D:mscd601 /1:D

6  Save the file and exit.
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Open and edit the CONFIG.SYS file. Add the following lines:

DEVICE=C:\DOS\HIMEM.SYS
DEVICEHIGH=C:\DOS\oakcdrom.sys /D:mscd001
LAST DRIVE=Z

Save the file and exit.
Restart the MS-DQOS 6.22 virtual machine.

As the installation configures the AUTOEXEC. BAT and CONFIG. SYS files, the CD-ROM drive appears in the
guest.

To install Windows 3.1x

1

Insert the Windows 3.1x Standard Installation Disks into the disk drive. and connect it to the guest from
the VM > Settings menu.

Run the SETUP program and follow the prompts to complete the installation.

When the installation completes, restart the guest.

Post Installation Considerations for MS-DOS 6.22 and Windows 3.1x

After you install MS-DOS 6.22, VMware recommends that you install a CPU idle program within the virtual
machine. Most versions of MS-DOS 6.22 do not idle the CPU when they are idle. As a result, when you run
MS-DOS 6.22 in a virtual machine, the virtual machine takes up CPU time on the host even when MS-DOS 6.22
is idle. VMware products rely on the guest operating system to use the Halt instruction or advanced power
management to unschedule the virtual machine when it is idle.

Run Windows 3.1x in full screen mode to avoid intermittent and erratic mouse behavior.

VMware Tools

No VMware Tools package exists for MS-DOS 6.22 or Windows 3.1x guest operating systems. As a result,
Windows 3.1x is limited to VGA mode graphics, and you must always use the Ctrl+Alt key combination to
release the mouse from a MS-DOS 6.22 or Windows 3.1x virtual machine.

VMware, Inc.
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Asianux Server 3.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Asianux Server 3.0 in a virtual machine is to use the standard Asianux
distribution CD. Installing Asianux 3.0 via the boot floppy/network method is also supported. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing Asianux Server 3.0:

Create and configure a new virtual machine.

Installation Steps

1
2
3

Insert the Asianux Server 3.0 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Asianux Server 3.0.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

In the Package Group Selection screen, choose Software Development and select individual packages. In
the Individual Package Selection screen, use the arrow keys to move down to System
Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should appear
between the brackets). The SMP kernel is not supported in a virtual machine. You do not need to change
any other selections.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen, or partition the
virtual disk manually if you do not want to use the Asianux defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

Click Yes to partition the drive.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

This completes basic installation of the Asianux Server 3.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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CentOS 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing CentOS 5.0 in a virtual machine is to use the standard CentOS distribution
CD. Installing CentOS 5.0 via the boot floppy/network method is also supported. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these prerequisites before installing CentOS 5.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for CentOS 5.0:

B Select Red Hat Enterprise Linux 5 or Red Hat Enterprise Linux 5 64-bit for the guest operating system
when creating the virtual machine. CentOS 5 is not listed as an option.

®  Configure the virtual machine with a minimum of 512MB of memory. If the virtual machine has less than
512MB of memory, CentOS 5.0 displays an error message as it loads certain VMware drivers.

®  Use the LSI Logic SCSI adapter. CentOS 5.0 does not include a driver for the BusLogic SCSI adapter.

B On a Linux host with an XFree86 3.x X server, do not run a screen saver in the guest operating system.
Guest screen savers that demand a lot of processing power can cause the X server on the host to freeze.

Installation Steps
1 Insert the CentOS 5.0 CD-ROM in the CD-ROM drive.
2 Power on the virtual machine to start installing CentOS 5.0.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Do not select the Virtualization Option during the installation. Refer to knowledge base article 9134325 at
http://kb.vmware.com/kb/9134325 for more information.

5  Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the CentOS defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

6  Click Yes to partition the drive.

This completes basic installation of the CentOS 5.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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CentOS 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing CentOS 4.0 in a virtual machine is to use the standard CentOS distribution
CD. You can also install CentOS 4.0 with the boot floppy/network method. If your VMware product supports
it, you can also install from a PXE server.

Fulfill these prerequisites before installing CentOS 4.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for CentOS 4.0:

B Select Red Hat Enterprise Linux 4 or Red Hat Enterprise Linux 4 64-bit for the guest operating system.
CentOS 4 is not listed as an option.

®  Configure the virtual machine with a minimum of 512MB of memory. If the virtual machine has less than
512MB of memory, CentOS 4.0 displays an error message as it loads certain VMware drivers.

B Select the LSI Logic SCSI adapter. CentOS 4.0 does not include a driver for the BusLogic SCSI adapter.

Installation Steps
1  Insert the CentOS 4.0 CD-ROM in the CD-ROM drive.
2 Power on the virtual machine to start installing CentOS 4.0.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Do not select the Virtualization Option during the installation. Refer to knowledge base article 9134325 at
http://kb.vmware.com/kb/9134325 for more information.

5  Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the CentOS defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

6  Click Yes to partition the drive.

This completes basic installation of the CentOS 4.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Debian 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Debian 5.0 in a virtual machine is to use the standard Debian 5.0 distribution
CD.

Fulfill these prerequisites before installing Debian 5.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Debian 5.0:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Debian 5.0 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Debian 5.0.

3 Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Debian 5.0 user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE For Debian 5.0, install VMware Tools using the tar installer.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Debian 4.0 in a virtual machine is to use the standard Debian 4.0 distribution
CD.

Fulfill these prerequisites before installing Debian 4.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Debian 4.0:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Debian 4.0 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Debian 4.0.

3 Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Debian 4.0 user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE For Debian 4.0, install VMware Tools using the tar installer.
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IBM OS/2 Warp 4.5.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing IBM OS/2 Warp 4.5.2 in a virtual machine is to use the standard
distribution CD.

Fulfill these requirements before you install OS/2 Warp 4.5.2:

B Create and configure a virtual machine.

®  Configure OS swap with at least 120MB of space.

®  Have both the OS/2 Warp 4.5.2 boot disk CD and the OS/2 Warp 4.5.2 install CD available for install.
Consider these support and configuration issues for IBM OS/2 Warp 4.5.2:

®  Additional disks should be less than or equal to 528MB.

®  Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM
OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The
same is true for LSI Logic and IDE.

Installation Steps
1  Insert the OS/2 Warp 4.5.2 boot disk in the CD drive.
Power on the virtual machine to start installing IBM OS/2 Warp 4.5.2.

Make sure Boot from CDROM Drive is enabled in the BIOS settings.

= W DN

After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.5.2 install CD into the
CD drive.

5  Press the F3 key to use the command line interface to partition the hard drive.
Alternatively, press Enter to select the GUI mode.

6  Partition the hard disk drive using the FDISK utility. Create an appropriate start volume on which to
install the guest, and save the FDSIK settings.

7 Reinsert the OS/2 Warp 4.5.2 boot disk in the CD drive and reboot the guest.

8  After the initial startup completes, insert the OS/2 Warp 4.5.2 install CD in the CD drive.
The start volume is displayed on the screen.

9  Select an appropriate volume to install the guest.

10 Format the filesystem with File Allocation Table (FAT) File System or High Performance File System
(HPES).

11 Continue the installation by selecting components, utilities, and other resources.

12 After completing the installation, reboot the guest.

Create Boot Disks

Create boot disks from the 32-bit OS/2 Warp 4.5.2 install CD, using the CDINST utility on a running OS/2 Warp
4.5.2 guest.

1  Power on a system in which 32-bit OS/2 Warp 4.5.2 is installed.
Insert the 32-bit OS/2 Warp 4.5.2 install CD into the CD drive.

Double-click on the CDINST utility that is located in the root directory.

= W N

Insert blank disks, one by one respectively.

This creates bootable disks for 32-bit OS/2 Warp 4.5.2.
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VMware Tools
There is no version of VMware Tools that supports IBM OS/2 Warp 4.5.2.
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IBM OS/2Warp 4.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing IBM OS/2 Warp 4.0 in a virtual machine is to use the standard distribution CD.
Fulfill these requirements before you install OS/2 Warp 4.0:

®  Create and configure a new virtual machine.

B Create a minimum of 120 MB for OS swap space.

®  Have both the OS/2 Warp 4.0 boot disk CD and the OS/2 Warp 4.0 install CD available for install.
Consider these support and configuration issues for IBM OS/2 Warp 4.0:

B Additional disks size should be less than or equal to 528MB.

B Additional disks have to be of the same type already in use by the virtual machine. For example, if an IBM
OS/2 Warp guest is installed on a BusLogic disk, any additional disks should also be BusLogic disks. The
same is true for LSI Logic and IDE.

Installation Steps
1  Insert the first OS/2 Warp 4.0 installer disk in the disk drive.
Make sure Boot from Removable Devices-Legacy Floppy Drives isenabled from the BIOS settings.

Insert the second and third installer disks when requested.

= W DN

After installing the required drivers from the third disk, insert the OS/2 Warp 4.0 install CD into the CD
drive.

5  After installing the required drivers from the boot disk CD, insert the OS/2 Warp 4.0 install CD into the
CD drive.

6  Press the F3 key to use the command line interface to partition the hard drive.
Alternatively, press Enter to select the GUI mode.

7 Partition the hard disk drive using the FDISK utility. Create an appropriate start volume on which to
install the guest, and save the FDSIK settings.

8  Re-insert the first OS/2 Warp 4.0 installer disk in the CD drive and reboot the guest.

9  Re-insert the second and third installer disks during the initial startup.

10 After the initial startup completes, insert the OS/2 Warp 4.0 install CD in the CD drive.
The start volume is displayed on the screen.

11 Select an appropriate volume to install the guest.

12 Format the filesystem with File Allocation Table (FAT) File System or High Performance File System
(HPES).

13 Continue the installation by selecting components, utilities, and other resources.

14 After completing the installation, reboot the guest.

Create Boot Disks

Create boot disks from the 32-bit OS/2 Warp 4.0 install CD, using the CDINST utility on a running OS/2 Warp
4.0 guest.

1  Power on a system in which 32-bit OS/2 Warp 4.0 is installed.
2 Insert the 32-bit OS/2 Warp 4.0 install CD into the CD drive.

3 Double-click on the CDINST utility that is located in the root directory.
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4  Insert three blank disks, one by one, respectively.

This creates bootable disks for 32-bit OS/2 Warp 4.0.

VMware Tools
There is no version of VMware Tools that supports IBM OS/2 Warp 4.0
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Mac OS X Server 10.5

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

Fulfill these requirements before you install Mac OS X Server 10.5:

B Before creating a virtual machine, obtain the operating system and any necessary product keys for
installation in that virtual machine.

B VMware Fusion does not come with any operating systems to install in the virtual machines you create.

B Create and configure a virtual machine.

Consider these support issues for Mac OS X Server 10.5:

B Use the Mac OS X disk utility to increase the size of the disk partition after installing the operating system
(If you increase the size of the disk partition when creating the virtual machine, you will not gain access
to additional space.)

Installation Steps

1 From the Virtual Machine Library window, click the New button, or choose File > New.

The New Virtual Machine Assistant starts.

2 In the Introduction panel, what you do depends on whether you are using an operating system

installation CD, an operating system installation disk image file (ISO), or an existing virtual disk:

Option

Description

Operating system
installation disk

Insert the disk into your Mac. VMware Fusion detects it and asks for confirmation that it is
the operating system you want to install. If it is the correct OS, ensure that Install this
operating system is selected and click Continue.

If it is not the correct OS, select Install a different operating system and click Continue.

Operating system
installation disk
image file

Click Continue without disk.

Existing virtual disk

Click Continue without disk.

3 In the Installation Media panel, choose one of four options:

Option

Description

Use operating system
installation disk

Use the pop-up menu to choose an operating system installation disk.

Use operating system
installation disk
image file

Use the pop-up menu to browse for the .iso file for the operating system. Click Choose to
identify the file.

Use an existing
virtual disk

Select this option to use an existing virtual disk. Use the pop-up menu to browse for the
existing virtual disk (.vmdk) file. Click Choose to identify the file.

Create a custom
virtual machine

Select this option if you are creating a custom virtual machine. For instance, you would use
this if you are installing an older operating system off of floppy images.

4  Click Continue to go to the Operating System panel.

5 Inthe Operating System panel, ensure that the operating system and version for the new virtual machine
are correct, or select the correct ones from the pop-up menus. Click Continue.

VMware, Inc.
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6  In the Finish panel:

Option Description

To create the virtual Click Finish.
machineaccordingto  Once you indicate the folder in which you want to save the virtual machine (default is your

the specifications <user>/Documents/Virtual Machines folder), clicking Save launches the virtual
listed in the Finish machine.

panel

To change disk size Click Customize Settings. Save the new virtual machine.

or other standard Once you save the new virtual machine, Fusion displays the Settings window, with which
settings of the virtual  you can make changes to the virtual machine’s disk size, processor usage, removable
machine devices, and so on. When you close the Settings window, VMware Fusion launches the

virtual machine.

This completes basic set up of the virtual machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandriva Corporate Desktop 4

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandriva Corporate Desktop 4 in a virtual machine is to use the standard
Mandriva Linux distribution CD. You can also install Mandriva Corporate Desktop 4 with a boot
floppy/metwork method is supported. If your VMware product supports it, you can also install from a PXE
server.

Fulfill these requirements before you install Mandriva Corporate Desktop 4:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Corporate Desktop 4:

During the Mandriva Corporate Desktop 4 installation, you are offered a choice of XFree86 X servers. You
can choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Corporate Desktop 4.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

On a Linux host with an XFree86 3.x X server, it is best not to run a screen saver in the guest operating
system. Guest screen savers that demand a lot of processing power can cause the X server on the host to
freeze.

Installation Steps

1
2
3

Insert the Mandriva Corporate Desktop 4 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandriva Corporate Desktop 4.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Corporate Desktop 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandriva Corporate Server 4

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandriva Corporate Server 4 in a virtual machine is to use the standard
Mandriva Linux distribution CD. You can also install Mandriva Corporate Server 4 with the boot
floppy/network method. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Corporate Server 4:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Corporate Server 4:

During the Mandriva Corporate Server 4 installation, you are offered a choice of XFree86 X servers. You
can choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Corporate Server 4.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

On a Linux host with an XFree86 3.x X server, it is best not to run a screen saver in the guest operating
system. Guest screen savers that demand a lot of processing power can cause the X server on the host to
freeze.

Installation Steps

1
2
3

Insert the Mandriva Corporate Server 4 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandriva Corporate Server 4.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Corporate Server 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandriva Linux 2008

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandriva Linux 2008 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2008 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2008:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2008:

During the Mandriva Linux 2008 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Linux 2008.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandriva Linux 2008 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandriva Linux 2008.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2008 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandriva Linux 2007

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandriva Linux 2007 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2007 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2007:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2007:

During the Mandriva Linux 2007 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Linux 2007.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandriva Linux 2007 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandriva Linux 2007.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2007 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandriva Linux 2006

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandriva Linux 2006 in a virtual machine is to use the standard Mandriva
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandriva Linux 2006 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandriva Linux 2006:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandriva Linux 2006:

During the Mandriva Linux 2006 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Linux 2006.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandriva Linux 2006 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandriva Linux 2006.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandriva Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandriva Linux 2006 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 10.1 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 10.1 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 10.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Mandrake Linux 10.1:

B During the Mandrake Linux 10.1 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Linux 10.1.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Mandrake Linux 10.1 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Mandrake Linux 10.1.

3 Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

5 In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
automatically allocate the space. Select Use free space.

6  When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use
B VMware virtual video card
®  No when asked if you want to install updates to the packages
®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandrake Linux 10.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

With a Mandrake Linux guest, you should install VMware Tools from the Linux console. Do not start X until
you have installed VMware Tools.

NOTE As you are installing and configuring VMware Tools, the configuration program asks for the location
of Ispci. When that prompt appears, enter the following path:

/usr/bin/1spcidrake
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Mandrake Linux 10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 10 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 10 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 10:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandrake Linux 10:

During the Mandrake Linux 10 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run that X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 10.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandrake Linux 10 CD in the CD-ROM drive.
Power on the virtual machine to start installing Mandrake Linux 10.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.

In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
automatically allocate the space. Select Use free space.

When you reach the Summary screen, configure the graphical interface.
Select Graphical Interface, and then click Do. Make the following selections:
®  The resolution and refresh rate you want your guest to use

B VMware virtual video card

®  No when asked if you want to install updates to the packages

®  No when asked if you want to start X when you reboot

This completes basic installation of the Mandrake Linux 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Mandrake Linux 9.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

50

The easiest method of installing Mandrake Linux 9.2 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 9.2 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 9.2:

Create and configure a new virtual machine.

Consider these support and configuration issues for Mandrake Linux 9.2:

During the Mandrake Linux 9.2 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run that X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 9.2.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

Insert the Mandrake Linux 9.2 CD in the CD-ROM drive.
Power on the virtual machine.
Install this operating system as you would on a physical machine.

The following steps include only those steps that are specific to installing this guest on a VMware virtual
machine.

Click in the opening screen and press F1 to install using text mode.
At the command line, type text and press Enter.

In the DrakX Partitioning wizard found the following solutions screen, select Use free space and select
Next.

Unless you have special disk requirements, let Mandrake Linux allocate the space.

When you reach the Package Group Selection screen, select the type of computer on which you installed
your VMware product.

If you installed your VMware product on a laptop computer, make the following selections:
a  Click Advanced.

b  Select Individual package selection and select Next.

¢ Scroll to numlock and deselect the asterisk and select Next.

If you do not disable numlock when you install the guest on a laptop, the number lock is always
active in the guest. You cannot disable it by pressing the Num Lock key.

When you reach the Summary screen, select Graphical interface and select Do.
Make the following selections for the graphical interface:
B A monitor for the guest

B VMware virtual video card

XFree 4.3

The resolution and refresh rate for the guest
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B No to not test the configuration
B No to not start X when you reboot
When you complete the graphical interface selections, the Summary screen reappears.
10 In the Summary screen, select Next.
11  Select No to not install updates to the packages.
12 Select Reboot to complete the basic installation of the Mandrake Linux 9.2 guest operating system.

This completes basic installation of the Mandrake Linux 9.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

With a Mandrake Linux 9.2 guest, you should install VMware Tools from the Linux console. Do not start X
until you have installed VMware Tools.

NOTE As you are installing and configuring VMware Tools, the configuration program asks for the location
of 1spci. When that prompt appears, enter the following path:

/usr/bin/1lspcidrake
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Mandrake Linux 9.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 9.1 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 9.1 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 9.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Mandrake Linux 9.1:

B During the Mandrake Linux 9.1 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run that X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 9.1.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Mandrake Linux 9.1 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Mandrake Linux 9.1.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5  Use the Expert installer.

6  In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
automatically allocate the space. Click Use free space.

7 VMware GSX Server: When selecting a boot loader, use LILO with text menu. Do not use the graphical
version of LILO. It causes the virtual machine to hang.

8 Do not create a custom boot disk when prompted.

9  Near the end of the installation, after files have been copied, you reach the monitor setup screen. Select
the resolution and refresh rate you want your guest to use. Select VMware virtual video card.

10 You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.1. This driver recognizes the
VMware SVGA driver.

11 When the installer asks if you want to test the configuration, answer No.
12 When the installer asks whether to start X when you reboot, answer No.
13 When the installer asks if you want to install updates to the packages, answer No.

This completes basic installation of the Mandrake Linux 9.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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With a Mandrake Linux 9.1 guest, you should install VMware Tools from the Linux console. Do not start X
until you have installed VMware Tools.

NOTE As you are installing and configuring VMware Tools, the configuration program asks for the location
of Ispci. When that prompt appears, enter the following path:

/usr/bin/1spcidrake
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Mandrake Linux 9.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 9.0 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 9.0 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 9.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Mandrake Linux 9.0:

B During the Mandrake Linux 9.0 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run that X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 9.0.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Mandrake Linux 9.0 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Mandrake Linux 9.0.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Use the text mode installer. At the opening screen, press F1 for options, and then enter text for text mode.
5  Use the Expert installer.

6  In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
automatically allocate the space. Click Use free space.

7 VMware GSX Server: When selecting a boot loader, use LILO with text menu. Do not use the graphical
version of LILO. It causes the virtual machine to hang.

8 Do not create a custom boot disk when prompted.

9  Near the end of the installation, after files have been copied, you reach the monitor setup screen. Select
the resolution and refresh rate you want your guest to use. Select VMware virtual video card.

10 You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.1. This driver recognizes the
VMware SVGA driver.

11 When the installer asks if you want to test the configuration, answer No.
12 When the installer asks whether to start X when you reboot, answer No.
13 When the installer asks if you want to install updates to the packages, answer No.

This completes basic installation of the Mandrake Linux 9.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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With a Mandrake Linux 9.0 guest, you should install VMware Tools from the Linux console. Do not start X
until you have installed VMware Tools.

NOTE As you are installing and configuring VMware Tools, the configuration program asks for the location
of Ispci. When that prompt appears, enter the following path:

/usr/bin/1spcidrake
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Mandrake Linux 8.2
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 8.2 in a virtual machine is to use the standard Mandrake
Linux distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Mandrake Linux 8.2 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 8.2:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Mandrake Linux 8.2:

B During the Mandrake Linux 8.2 installation, you are offered a choice of XFree86 X servers. You can choose
either one, but do not run that X server. Instead, to get an accelerated SVGA X server running inside the
virtual machine, you should install the VMware Tools package immediately after installing Mandriva
Linux 8.2.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Mandrake Linux 8.2 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Mandrake Linux 8.2.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Use the Expert installer.

5  In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
auto-allocate the space.

6  When selecting a boot loader, use LILO with text menu. Do not use the graphical version of LILO. It
causes the virtual machine to hang.

7 Do not create a custom boot disk when prompted.

8  You are offered a choice of 2 XFree86 X servers to install. Choose XFree 4.2.0. This driver recognizes the
VMware SVGA driver.

9  Near the end of the installation, after files have been copied, you reach the monitor setup screen. Choose
the resolution and refresh rate you want your guest to use.

10 When the installer asks if you want to test the configuration, answer No.
11 When the installer asks if you want to install system updates, answer No.
12 When the installer asks whether to start X when you reboot, answer No.

This completes basic installation of the Mandrake Linux 8.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

With a Mandrake Linux 8.2 guest, you should install VMware Tools from the Linux console. Do not start X
until you have installed VMware Tools.
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NOTE As you are installing and configuring VMware Tools, the configuration program asks for the location
of Ispci. When that prompt appears, enter the following path:

/usr/bin/1spcidrake
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Mandrake Linux 8.0 or 8.1 in a virtual machine is to use the standard
Mandrake Linux distribution CD. The notes below describe an installation using the standard distribution CD;
however, installing Mandrake Linux 8.0 or 8.1 via the boot floppy/network method is supported as well. If
your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Mandrake Linux 8.0 or 8.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Mandrake Linux 8.0 or 8.1:

B During the Mandrake Linux 8.0 or 8.1 installation, you are offered a choice of XFree86 X servers. You can
choose either one, but do not run that X server. Instead, to get an accelerated SVGA X server running
inside the virtual machine, you should install the VMware Tools package immediately after installing
Mandriva Linux 8.0 or 8.1.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Mandrake Linux 8.0 or 8.1 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Mandrake Linux 8.0 or 8.1.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Use the Expert installer.

5  In the partitioning step, unless you have special requirements, it is all right to let Mandrake Linux
auto-allocate the space.

6  When selecting a boot loader, use LILO with text menu. Do not use the graphical version of LILO. It
causes the virtual machine to hang.

7 On the Select a Graphic Card screen, choose Other>Generic VGA compatible.

8  Near the end of the installation, after files have been copied, you reach the monitor setup screen. Choose
Super VGA, 800x600 @ 56 Hz.

9  When the installer asks whether to start X when you reboot, answer No.

This completes basic installation of the Mandrake Linux 8.0 or 8.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NoTE With a Mandrake Linux 8.0 or 8.1 guest, you should install VMware Tools from the Linux console. Do
not start X until you have installed VMware Tools and set up a symbolic link to the XFree86 configuration file.

Setting Up a Symbolic Link to XFree86
Log on as root (su -), and then set up a symbolic link to the correct XFree86 configuration file.

cd /etc
1n -s /etc/X11/XF86Config.vm XF86Config
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Use the startx command to start your X server.
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Novell Linux Desktop 9

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Novell Linux Desktop 9 in a virtual machine is to use the standard Novell
Linux Desktop distribution CDs. The notes below describe an installation using the standard distribution CD;
however, installing Novell Linux Desktop 9 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Novell Linux Desktop 9:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Novell Linux Desktop 9:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Novell Linux Desktop 9 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Novell Linux Desktop 9.

3  Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode, and then press Enter to select the text mode installer.

4  During final configuration, after all packages are installed, do not perform the Internet connection test.
5 Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Novell Linux Desktop 9 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

60 VMware, Inc.


http://kb.vmware.com/kb/340

Installing Guest Operating Systems

Oracle Enterprise Linux 5

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Oracle Enterprise Linux 5 in a virtual machine is to use the standard
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Oracle Enterprise Linux 5 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Oracle Enterprise Linux 5:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Oracle Enterprise Linux 5:

B When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Oracle Enterprise Linux
5 does not include a driver for the BusLogic SCSI adapter.

B Be sure the virtual machine is configured with at least 512MB of memory. If the virtual machine has less
than 512MB of memory, Oracle Enterprise Linux 5 presents an error message as it loads certain VMware
drivers.

Installation Steps
1  Insert the Oracle Enterprise Linux 5 CD-ROM in the CD-ROM drive.
2 Power on the virtual machine to start installing Oracle Enterprise Linux 5.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Do not select Virtualization Option during the installation. Refer to knowledge base article 9134325 at
http://kb.vmware.com/kb/9134325 for more information.

5  Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

6  Click Yes to partition the drive.

This completes basic installation of the Oracle Enterprise Linux 5 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Red Hat Enterprise Linux 5

This section contains product support, installation instructions, and known issues for the Red Hat Enterprise
Linux 5 operating system.

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 5 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 5 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 5:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Red Hat Enterprise Linux 5:

B Be sure the virtual machine is configured with at least 512MB of memory. If the virtual machine has less
than 512MB of memory, Red Hat Enterprise Linux 5 presents an error message as it loads certain VMware
drivers.

B When creating the virtual machine, be sure to select the LSI Logic SCSI adapter. Red Hat Enterprise Linux
5 does not include a driver for the BusLogic SCSI adapter. Before installing the operating system, be sure
that you have already created and configured a new virtual machine

Installation Steps
1  Insert the Red Hat Enterprise Linux 5 CD-ROM in the CD-ROM drive.
2 Power on the virtual machine to start installing Red Hat Enterprise Linux 5.

3  Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4 Do not select Virtualization Option during the installation. Refer to knowledge base article 9134325 at
http://kb.vmware.com/kb/9134325 for more information.

5  Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.

6  Click Yes to partition the drive.

This completes basic installation of the Red Hat Enterprise Linux 5 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Red Hat Enterprise Linux 4

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 4 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 4 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 4:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 4:

VMware Workstation, VMware ACE, VMware GSX Server: When creating the virtual machine, be sure
to select the LSI Logic SCSI adapter. Red Hat Enterprise Linux 4 does not include a driver for the BusLogic
SCSI adapter.

Be sure the virtual machine is configured with at least 256MB of memory. If the virtual machine has less
than 256MB of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware
drivers.

The Red Hat Enterprise Linux 4 hugemem kernel is not supported. See knowledge base article 8964517 at
http://kb.vmware.com/kb/8964517.

SCSI adapter support

®  Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support
only the BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 1, 2, 3, 4, and 5.

B Red Hat Enterprise Linux 4, Update 6 and Update 7: ESX Server 2.5.2, 2.5.3, 2.5.4, and 2.5.5 support
both the LSI Logic and BusLogic SCSI adapter on Red Hat Enterprise Linux 4, Update 6 and Update 7.

B VMware provides a separate driver to support the BusLogic SCSI adapter. For instructions on
downloading and installing the BusLogic driver, see
www.vmware.com/download/esx/drivers_tools.html.

Installation Steps

NOTE Pay particular attention to the notes in Step 4 about how to avoid installing an inappropriate kernel.

1
2
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Insert the Red Hat Enterprise Linux 4 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Enterprise Linux 4.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

VMware GSX Server: In the Package Group Selection screen, choose Software Development and select
individual packages. In the Individual Package Selection screen, use the arrow keys to move down to
System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.

You might see a warning that begins “The partition table on device <devicename> was
unreadable. To create new partitions it must be initialized, causing the loss of ALL
DATA on the drive.” This does not mean that anything is wrong with the hard drive on your physical
computer. It simply means that the virtual hard drive in your virtual machine needs to be partitioned and
formatted.
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Click Yes to partition the drive.

7 VMware GSX Server: If your computer is connected to a LAN that provides DHCP support, in the
Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set
the networking parameters manually.

VMware ESX Server: If you are using the vlance network adapter in your virtual machine and your
computer is connected to a LAN that provides DHCP support, in the Network Configuration screen, you
can select the option Use bootp/dhcp. If you prefer, you can also set the networking parameters manually.
If you are using the vmxnet network adapter in your virtual machine, use the network configuration tools
in Red Hat Enterprise Linux 4 to configure your network connection after you finish installing the guest
operating system.

This completes basic installation of the Red Hat Enterprise Linux 4 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Red Hat Enterprise Linux 3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 3 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 3 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 3:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 3:

The Red Hat Enterprise Linux 3 hugemem kernel is not supported. See knowledge base article 8964517 at
http://kb.vmware.com/kb/8964517.

Be sure the virtual machine is configured with at least 256MB of memory. If the virtual machine has less
than 256MB of memory, Red Hat Enterprise Linux presents an error message as it loads certain VMware
drivers.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

NOTE Pay particular attention to the notes in Step 6 about how to avoid installing an inappropriate kernel.
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Insert the Red Hat Enterprise Linux 3 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Enterprise Linux 3.

You must install Red Hat Enterprise Linux 3 using the text mode installer, which you can choose when
you first boot the installer. At the Red Hat Enterprise Linux 3 CD boot prompt, you are offered a number
of choices, including the following;:

To install or upgrade Red Hat Linux ... in graphical mode ...
To install or upgrade ... in text mode, type: text <ENTER>...

Use the function keys listed below ...
To choose the text mode installer, type text and press Enter.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard, and then in the Installation Type screen, choose either Advanced
Server or Custom for the installation type.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons
option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose
Generic Wheel Mouse (PS/2).

VMware GSX Server only: In the Package Group Selection screen, choose Software Development and
Select individual packages. In the Individual Package Selection screen, use the arrow keys to move down
to System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.

You might see a warning that says:
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The partition table on device sda was unreadable. To create new partitions, it must be
initialized, causing the loss of ALL DATA on the drive.
Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select
the Yes button and press Enter. Also note that sda appears in the message as the device name if the virtual
disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device
name instead.

9  VMware GSX Server: If your computer is connected to a LAN that provides DHCP support, in the
Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can also set
the networking parameters manually.

VMware ESX Server, VMware VirtualCenter, or vCenter Server: If you are using the vlance network
adapter in your virtual machine and your computer is connected to a LAN that provides DHCP support,
in the Network Configuration screen, you can select the option Use bootp/dhcp. If you prefer, you can
also set the networking parameters manually. If you are using the vmxnet network adapter in your virtual
machine, use the network configuration tools in Red Hat Enterprise Linux 3 to configure your network
connection after you finish installing the guest operating system.

This completes basic installation of the Red Hat Enterprise Linux 3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Installing Guest Operating Systems

Red Hat Enterprise Linux 2.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Enterprise Linux 2.1 in a virtual machine is to use the standard Red
Hat distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Enterprise Linux 2.1 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Enterprise Linux 2.1:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Enterprise Linux 2.1:

Red Hat Enterprise Linux 2.1 WS on VMware ESX Server: When you install Red Hat Enterprise Linux
2.1 WS in a virtual machine on an ESX Server, use Update 6 or higher. This eliminates conflicts with the
network and SCSI adapters and installation problems on a Red Hat Enterprise Linux 2.1 WS guest
operating system.

If you do not install Update 6 or higher, use one of the following configurations for the network and SCSI
adapters:

B vlance network adapter —Use an LSI Logic SCSI adapter.
B vmxnet network adapter —Use an LSI Logic SCSI adapter or BusLogic adapter.

You should not run the X server that is installed when you set up Red Hat Enterprise Linux 2.1. Instead,
to get an accelerated SVGA X server running inside the virtual machine, you should install the VMware
Tools package immediately after installing Red Hat Enterprise Linux 2.1.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

NOTE Unless you are running a multiprocessor virtual machine under VMware ESX Server, pay particular

attention to the notes in Step 6 about how to avoid installing an inappropriate kernel.

1
2
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Insert the Red Hat Enterprise Linux 2.1 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Enterprise Linux 2.1.

You must install Red Hat Enterprise Linux 2.1 using the text mode installer, which you can choose when
you first boot the installer. At the Red Hat Enterprise Linux 2.1 CD boot prompt, you are offered a number
of choices, including the following:

To install or upgrade Red Hat Linux ... in graphical mode ...
To install or upgrade ... in text mode, type: text <ENTER>...

Use the function keys listed below ...
To choose the text mode installer, type text and press Enter.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard, and then in the Installation Type screen, choose either Advanced
Server or Custom for the installation type.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons
option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose
Generic Wheel Mouse (PS/2).
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6 VMware GSX Server only: In the Package Group Selection screen, choose Software Development and
Select individual packages. In the Individual Package Selection screen, use the arrow keys to move down
to System Environment/Kernel and press Enter. Be sure that kernel-smp is deselected (no asterisk should
appear between the brackets). The SMP kernel is not supported in a GSX Server virtual machine. You do
not need to change any other selections.

VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine without
virtual SMP: In the Individual Package Selection screen, use the arrow keys to move down to System
Environment/Kernel and press Enter. Be sure that the following kernels are deselected (no asterisk
should appear between the brackets):

B Kernel-enterprise
B Kkernel-smp
B kernel-summit

VMware ESX Server, VirtualCenter, or vCenter Server if installing to an ESX Server machine with
virtual SMP: In the Individual Package Selection screen, use the arrow keys to move down to System
Environment/Kernel and press Enter.

B If you are installing a multiprocessor virtual machine, be sure kernel-smp is selected.

®m  If you are installing a uniprocessor virtual machine, be sure the following kernels are deselected:
kernel-enterprise, kernel-smp and kernel-summit.

For additional information on using uniprocessor and multiprocessor kernels with a Red Hat Enterprise
Linux 2.1 virtual machine under VMware ESX Server, see the release notes at
www.vmware.com/support/esx21/doc/releasenotes_esx213.html.

7 Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.

8  You might see a warning that says:

The partition table on device sda was unreadable. To create new partitions, it must be
initialized, causing the loss of ALL DATA on the drive.
Would you like to initialize this drive?

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select
the Yes button and press Enter. Also note that sda appears in the message as the device name if the virtual
disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as the device
name instead.

9  If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

10 In the Video Card Configuration screen, choose Generic SVGA.

This completes basic installation of the Red Hat Enterprise Linux 2.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 9.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 9.0 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 9.0 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 9.0:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 9.0:

You should not run the X server that is installed when you set up Red Hat Linux 9.0. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 9.0.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
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Insert the Red Hat Linux 9.0 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 9.0.

You must install Red Hat Linux 9.0 using the text mode installer, which you can choose when you first
boot the installer. At the Red Hat Linux 9.0 CD boot prompt, you are offered the following choices:

To install or upgrade Red Hat Linux ... in graphical mode ...
To install or upgrade ... in text mode, type: linux text <ENTER>.
Use the function keys listed below ...

To choose the text mode installer, type Tinux text and press Enter.

NOTE If you attempt to use the graphical installer, it fails and launches the text mode installer.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons
option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose
Generic Wheel Mouse (PS/2).

In the Installation Type screen, choose either Server or Workstation for the installation type.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.

You might see a warning that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select
the Initialize button and press Enter. Also note that sda appears in the message as the device name if the
virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as
the device name instead.

69



Guest Operating System Installation Guide

70

9  If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

10 In the Video Card Configuration screen, choose Skip X Configuration.

This completes basic installation of the Red Hat Linux 9.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.

NOTE When you are installing VMware Tools, the configuration program asks you to specify a resolution for
the guest operating system’s display. Set the resolution to 1152 x 864 or lower. If you set a higher resolution,
the guest operating system instead switches to a default resolution of 800 x 600.
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Installing Guest Operating Systems

Red Hat Linux 8.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 8.0 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 8.0 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 8.0:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 8.0:

You should not run the X server that is installed when you set up Red Hat Linux 8.0. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 8.0.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
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Insert the Red Hat Linux 8.0 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 8.0.

You must install Red Hat Linux 8.0 using the text mode installer, which you can choose when you first
boot the installer. At the Red Hat Linux 8.0 CD boot prompt, you are offered the following choices:

To install or upgrade Red Hat Linux ... in graphical mode ...
To install or upgrade ... in text mode, type: linux text <ENTER>.
Use the function keys listed below ...

To choose the text mode installer, type Tinux text and press Enter.

NOTE If you attempt to use the graphical installer, it fails and launches the text mode installer.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard, and then in the Installation Type screen, choose either Server or
Workstation for the installation type.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the Emulate 3 Buttons
option for three-button mouse support in the virtual machine. If you have a wheel mouse, you can choose
Generic Wheel Mouse (PS/2).

You might see a warning that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select
the Initialize button and press Enter. Also note that sda appears in the message as the device name if the
virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as
the device name instead.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen or partition the
virtual disk manually if you do not want to use the Red Hat defaults.
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8  If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

9  In the Video Card Configuration screen, choose Skip X Configuration.

This completes basic installation of the Red Hat Linux 8.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 7.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 7.3 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 7.3 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 7.3:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 7.3:

You should not run the X server that is installed when you set up Red Hat Linux 7.3. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 7.3.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
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Insert the Red Hat Linux 7.3 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 7.3.

You must install Red Hat Linux 7.3 using the text mode installer, which you can choose when you first
boot the installer. At the Red Hat Linux 7.3 CD boot prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...
To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode,
Use the function keys listed below ...

To choose the text mode installer, type text and press Enter.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the option Emulate 3
Buttons for three-button mouse support in the virtual machine.

Choose the language and keyboard, and then in the Installation Type screen, choose either Server or
Workstation for the installation type.

You might see a warning that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Select
the Initialize button and press Enter. Also note that sda appears in the message as the device name if the
virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as
the device name instead.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

In the Video Card Selection screen, choose any card from the list.
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10 In the Video Card Configuration screen, choose Skip X Configuration.

This completes basic installation of the Red Hat Linux 7.3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 7.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 7.2 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 7.2 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 7.2:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 7.2:

You should not run the X server that is installed when you set up Red Hat Linux 7.2. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 7.2.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
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Insert the Red Hat Linux 7.2 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 7.2.

You must install Red Hat Linux 7.2 using the text mode installer, which you can choose when you first
boot the installer. At the Red Hat Linux 7.2 CD boot prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...

To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode,

Use the function keys listed below ...

To choose the text mode installer, type text followed by Enter.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard, and then in the Installation Type screen, choose either Server or
Workstation for the installation type.

A warning appears that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Click the
Initialize button and press Enter. Also note that sda appears in the message as the device name if the
virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as
the device name instead.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the option Emulate 3
Buttons for three-button mouse support in the virtual machine.

In the Video Card Selection screen, choose the default selection.
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9  During the configuration of the X server, select the defaults and proceed through this section as quickly

as possible, as this X server is replaced by an X server specific to your guest operating system when you
install VMware Tools in this virtual machine.

10 Continue to the Starting X screen and click the Skip button to skip testing the configuration.

This completes basic installation of the Red Hat Linux 7.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start X until you have installed VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 7.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 7.1 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 7.1 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 7.1:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 7.1:

You should not run the X server that is installed when you set up Red Hat Linux 7.1. Instead, to get an
accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 7.1.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
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Insert the Red Hat Linux 7.1 CD-ROM in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 7.1.

You must install Red Hat Linux 7.1 using the text mode installer, which you can choose when you first
boot the installer. At the Red Hat Linux 7.1 CD boot prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...

To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode,

Use the function keys listed below ...

To choose the text mode installer, type text followed by Enter.

Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

Choose the language and keyboard, and then in the Installation Type screen, choose either Server or
Workstation for the installation type.

A warning appears that says:

Bad partition table. The partition table on device sda is corrupted. To create new
partitions, it must be initialized, causing the loss of ALL DATA on the drive.

This does not mean that anything is wrong with the hard drive on your physical computer. It simply
means that the virtual hard drive in your virtual machine needs to be partitioned and formatted. Click the
Initialize button and press Enter. Also note that sda appears in the message as the device name if the
virtual disk in question is a SCSI disk; if the virtual disk is an IDE drive, hda appears in the message as
the device name instead.

Allow automatic partitioning of the disk to occur in the Automatic Partitioning screen.

If your computer is connected to a LAN that provides DHCP support, in the Network Configuration
screen, you can select the option Use bootp/dhcp. If you prefer, you can also set the networking
parameters manually.

In the Mouse Selection screen, choose Generic — 3 Button Mouse (PS/2) and select the option Emulate 3
Buttons for three-button mouse support in the virtual machine.

In the Video Card Selection screen, choose the default selection.
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9  During the configuration of the X server, select the defaults and proceed through this section as quickly

as possible, as this X server is replaced by an X server specific to your guest operating system when you
install VMware Tools in this virtual machine.

10 Continue to the Starting X screen and click the Skip button to skip testing the configuration.

This completes basic installation of the Red Hat Linux 7.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start X until you have installed VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 7.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 7.0 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 7.0 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Red Hat Linux 7.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Red Hat Linux 7.0:

B During the Red Hat Linux 7.0 text mode installation, a standard XFree86 version 4 server (without
support for VMware SVGA or standard VGA) will be installed. Do not run that X server. Instead, to get
an accelerated SVGA X server running inside the virtual machine, you should install the VMware Tools
package immediately after installing Red Hat Linux 7.0.

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Red Hat Linux 7.0 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Red Hat Linux 7.0.

We recommend you install the operating system with the text mode installer. At the Red Hat 7.0 CD boot
prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...

To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode, ...

Use the function keys listed below ...

Choose the text mode installer by typing text followed by Enter.

3 Follow the installation steps as you would for a physical machine. Be sure to make the choices outlined in
the following steps.

4  In Video Card Selection choose Generic VGA compatible, and then click OK.

5  Near the end of the installation, after files have been copied, you reach the Monitor Setup screen. Choose
Generic Standard VGA, 640x480 @ 60 Hz, and then click OK.

6 At the Video Memory screen, choose 256Kb, and then click OK.

7 At the Clockchip Configuration screen, choose No Clockchip Setting (recommended), which is the
default, and then click OK.

8 At the Probe for Clocks screen, click Skip.
9 At the Select Video Modes screen, don't choose anything. Just click OK.

10 At the Starting X screen, click Skip.

NOTE This is the most important step. Clicking OK runs the XFree86 version 4 server, which fails, and
the installer aborts.

This completes basic installation of the Red Hat Linux 7.0 guest operating system.
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VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NoTE With a Red Hat Linux 7.0 guest, you should install VMware Tools from the Linux console. Do not start
X until you have installed VMware Tools.
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Installing Guest Operating Systems

Red Hat Linux 6.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Red Hat Linux 6.2 in a virtual machine is to use the standard Red Hat
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Red Hat Linux 6.2 via the boot floppy/network method is supported as well.

Fulfill these requirements before you install Red Hat Linux 6.2:

Create and configure a new virtual machine.

Consider these support and configuration issues for Red Hat Linux 6.2:

During the Red Hat Linux 6.x installation, a standard VGA16 X server (without support for the VMware
X server) is installed. To run an accelerated SVGA X server inside the virtual machine, install the VMware
Tools package immediately after installing Red Hat Linux 6.x.

Due to VGA performance issues installing Red Hat 6.2 with the graphics mode installer, we highly
recommend you install the operating system with the text mode installer. At the Red Hat 6.0.1 or 6.2 CD
boot prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...

To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode,

Use the function keys listed below ...

Choose the text mode installer by typing text followed by Enter.

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

CAUTION Red Hat Linux 6.2 runs on Intel core processors. However, it does not run on Xeon processors that

are branded Xeon, with no qualifier, or Xeon-MP (Pentium III Xeon processors are OK).

Installation Steps

1
2
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Insert the Red Hat Linux 6.2 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing Red Hat Linux 6.2.

We recommend you install the operating system with the text mode installer. At the Red Hat 6.2 CD boot
prompt, you are offered the following choices:

To install or upgrade a system ... in graphical mode ...

To install or upgrade a system ... in text mode, type: text <ENTER>.
To enable expert mode,

Use the function keys listed below ...

Choose the text mode installer by typing text followed by Enter.

Follow the installation steps as you would for a physical machine.

NOTE If the virtual machine’s Ethernet adapter has been enabled, the installation program auto-detects
and loads the AMD PC/Net 32 driver (no command line parameter is necessary to load the driver).

NOTE The text mode installer in Red Hat Linux 6.2 presents a Hostname Configuration screen. If you are
installing this guest with DHCP in a virtual machine with host-only networking, do not specify a host
name. Just respond OK and continue. (Specifying a host name will cause an installer error later.) At the
next screen—Network Configuration —respond OK to use the default: Use bootp/dhcp.

During the Linux installation, select the standard VGA16 X server.

In the Choose a Card screen, select the Generic VGA compatible/Generic VGA card from the list.
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6  Inthe Monitor Setup screen, select Generic Monitor from the list.
7 Select the Probe button from the Screen Configuration dialog box.

8  Select OK from the Starting X dialog box. After Linux is installed, the generic X server is replaced with the
accelerated X server included in the VMware Tools package when you install VMware Tools.

9  Finish installing Red Hat Linux 6.2 as you would on a physical machine.
At this point Red Hat 6.2 boots and a login screen appears.

This completes basic installation of the Red Hat Linux 7.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Sun Java Desktop System 2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Sun Java Desktop System 2 in a virtual machine is to use the standard Sun
Java Desktop System distribution CDs. The notes below describe an installation using the standard
distribution CD; however, installing Sun Java Desktop System 2 via the boot floppy/network method is
supported as well. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Sun Java Desktop System 2:

B Create and configure a new virtual machine.

Installation Steps
1  Insert the Sun Java Desktop System 2 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Sun Java Desktop System 2.
3  Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Sun Java Desktop System 2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SCO OpenServer 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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You can install SCO OpenServer 5.0 in a virtual machine using the standard distribution CDs, via the boot
floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SCO OpenServer 5.0:

Create and configure a new virtual machine.

Consider these support and configuration issues for SCO OpenServer 5.0:

Virtual disk recommendations
B Minimum size — 1.5GiB for the SCO OpenServer 5.0 root disk.

B biosgeombootstring — Required for SCSI drives between 1 and 64GiB. (Not harmful to other drive
sizes.).

®  IDE virtual disks — SCO BTLD (wd boot-time loadable driver) for improved performance and
reliability.

B Special considerations for drive sizes:
®  OpenServer 5.0.7 — wd BTLD is required for IDE disks larger than 128GiB (137GB).
B OpenServer 5.0.6 — Cannot use IDE disks that are 128 GiB or larger.
Supported virtual disks
®  BusLogic SCSI - Requires SCO blc BTLD 3.05.1 or later.
®  LSISCSI - Requires SCO Isil BTLD 1.03.28 or later.
®  LSISAS - Requires LSI Logic Isil BTLD 1.04.09 or later.
m  IDE
®  Under 128GiB — no BTLD required.
®  128GiB or more - 5.0.7 only, requires SCO “wd” BTLD.
Downloadable drivers

Suitable NIC and HBA drivers are not included in the base SCO OpenServer 5.0 distributions and need
to be downloaded from the Internet

B SCO Intel PRO/1000 network adapter driver (Search for the eeG driver.)
ftp://ftp.sco.com/pub/openserver5/drivers/

B SCOIDE BTLD, located on the SCO FTP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/wd_3.0/

®  SCO BusLogic BTLD 3.05.1, located on the SCO FIP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/blc_3.05.1/

m  SCO LSI Logic BTLD 1.03.28, located on the SCO FIP Web site:
ftp://ftp.sco.com/pub/openserver5/507/drivers/lsil_1.03.28/

®  LSI Logic LSISAS BTLD 1.04.09, located on the LSI Logic Web site:

http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/SCO/SCO_op
5_mpt_lsil_10409.zip

http://www.lsi.com/DistributionSystem/AssetDocument/files/support/ssp/fusionmpt/sas/linux/scou
nix_10409.txt
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NOTE Floppy images must be renamed with a .f1p extension to be accepted by ESX. The location of the
floppy images on the LSI Web site do not appear to be static. If you cannot locate the floppy images at the
addresses VMware provided, try contacting an LSI representative

Installation Steps

The installation steps vary slightly between SCO OpenServer 5.0.6 and 5.0.7-MP5. These instructions
document the differences.

1 Insert the SCO-OSR506-InstallCD for 5.0.6 (or SCO-OSR507-InstallCD for 5.0.7) in the CD-ROM drive.
Alternatively, you can insert the SCO-OSR506-BootDisk (or SCO-OSR507-BootDisk for 5.0.7) floppy in the
floppy drive.

2 2Power on the virtual machine to start installing SCO OpenServer 5.0.6 or 5.0.7.
3 Install the appropriate SCSI drivers by typing one of the following boot strings:
m  IDE disk under 128GiB (137GB)
No boot string required, press Enter.
m  IDE disk 128GiB (137GB) or larger (5.0.7 only)
restart link="wd”
When prompted to replace the driver, typer.
®  Buslogic
restart link="blc" biosgeom
When prompted to replace the driver, type r.
m  LSI Logic SCSI or SAS
restart link="1sil" biosgeom

4  Insert the appropriate installation disks when prompted.
5 Read and accept the license agreement.
6  Accept the default CD-ROM type and controller/drive configuration.
The Open Server 5.0 install checks for the drive type and defaults to the configuration.
7 Follow the prompts to proceed with the installation.
8  Turn off the bad block scan, which is on by default for IDE disks.
The bad block scan is not necessary on a virtual disk.
9  When selecting the mouse, press h to specify High Resolution Keyboard Mouse.

10 Follow the remainder of the installation steps to complete the installation.

Install Maintenance Pack 5

After installing Open Server 5.0.7, install Maintenance Pack 5 (MP5).

1  Power on the OpenServer 5.0.7 guest.

If you used biosgeom during the install, boot the guest with the defbootstr biosgeom command.

Insert the SCO-OSR507-SuppCD5 CD in the CD-ROM drive.

= W N

Install MP5 using the Software Manager.

NOTE After MP5 is installed, the virtual machine will boot normally without requiring biosgeom.

This completes basic installation of the OpenServer 5.0. guest operating system.
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VMware Tools

There is no version of VMware Tools that supports SCO OpenServer 5.0.
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SCO UnixWare 7

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install SCO UnixWare 7 in a virtual machine using the standard distribution CDs, via the boot
floppy/network method, and if your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SCO UnixWare 7:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SCO UnixWare 7:

B SCO UnixWare 7 runs very slowly without assistance from CPU virtualization hardware. For near-native
performance, the host must have support for nested page tables. This is found in AMD Barcelona and later
CPUs with Rapid Virtualization Indexing (RVI) and in Intel Nehalem and later CPUs with Extended Page
Tables (EPT).

Installation Steps
1 Insert the SCO UnixWare 7.1.1 or 7.1.4 boot CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SCO UnixWare 7.
3 If you selected LSILOGIC/ LSISAS for SCSI adapter, then select Install HBA disk.
4  Insert the HBA disk.

This completes basic installation of the SCO UnixWare 7 guest operating system.

Install SCO UnixWare Maintenance Packs

After installing the guest operating system, install UnixWare 7.1.1 Maintenance Pack 5 (MP5) or UnixWare
7.1.4 Maintenance Pack 4 (MP4) and patch p535283, according to SCO instructions.

The Maintenance Packs are located here:
m  UnixWare 7.1.1 MP5 - ftp: //ftp.sco.com/pub/unixware7/uw711pk
B UnixWare 7.1.4 MP4 - ftp://ftp.sco.com/pub/unixware7/714/mp/uw714mp4/

If you use more than one virtual CPU in this guest, install the OS Multiprocessor Support (OSMP) package,
which is not automatically installed. An additional SCO CPU license is required for each additional CPU. For
example, if you use four virtual CPUs, you need one operating system license and three CPU licenses.

Install and Configure SMP

Install OSMP and any necessary licenses according to SCO documentation.

VMware Tools

There is no version of VMware Tools that supports SCO UnixWare.
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SUSE Linux Enterprise Desktop 11

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Desktop 11 in a virtual machine is to use the standard
SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux Enterprise Desktop 11 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Desktop 11:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux Enterprise Desktop 11:

B VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system

Installation Steps
1  Insert the SUSE Linux Enterprise Desktop 11 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux Enterprise Desktop 11.
3  Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise Desktop 11 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux Enterprise Desktop 10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Desktop 10 in a virtual machine is to use the standard
SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux Enterprise Desktop 10 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 10:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux Enterprise Server 10:

B VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system

Installation Steps
1  Insert the SUSE Linux Enterprise Desktop 10 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux Enterprise Desktop 10.

3 Install using the text mode installer. In the first installation screen, use the arrow keys to select
Installation, press the F2 key, use the arrow keys to choose text mode, and then press Enter to select the
text mode installer.

4 At the Installation Settings screen, go to the Change menu and choose Booting,.
5  The Boot Loader Setup screen appears. Set the Boot Loader Type to LILO instead of the default GRUB.

6  The installer displays a warning that indicates you might lose some settings and prompts you to select a
course of action. Select Convert current configuration and continue.

7  Select Finish to return to the Installation Settings screen.
8  Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise Desktop 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux Enterprise Server 11
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 11 in a virtual machine is to use the standard
SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux Enterprise Server 11 with the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 11:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux Enterprise Server 11:

B VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system

Installation Steps
1  Insert the SUSE Linux Enterprise Server 11 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux Enterprise Server 11.
3 Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise Server 11 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux Enterprise Server 10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 10 in a virtual machine is to use the standard
distribution CDs. However, installing SUSE Linux Enterprise Server 10 using the boot floppy/network method
is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 10:

Create and configure a new virtual machine.

When you create a virtual machine for SUSE Linux Enterprise Server 10 with Novell Open Enterprise
Server on an ESX Server, select Linux for the guest operating system and Open Enterprise Server for the
version.

Consider these support and configuration issues for SUSE Linux Enterprise Server 10:

VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

7
8

Insert the SUSE Linux Enterprise Server 10 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SUSE Linux Enterprise Server 10.

Install using the text mode installer. In the first installation screen, use the arrow keys to select
Installation, enter the boot option textmode=1, and then press Enter to select the text mode installer.

At the Installation Settings screen, go to the Change menu and select Booting.
The Boot Loader Setup screen appears.
Set the Boot Loader Type to GRUB.

The installer displays a warning that indicates you might lose some settings and prompts you to select a
course of action. Select Convert current configuration and continue.

Select Finish to return to the Installation Settings screen.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux Enterprise Server 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a

listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

VMware, Inc.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 9 in a virtual machine is to use the standard

distribution CDs. However, installing SUSE Linux Enterprise Server 9 using the boot floppy/network method

is also supported. If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 9:

Create and configure a new virtual machine.

When you create a virtual machine for SUSE Linux Enterprise Server 9 with Novell Open Enterprise
Server on an ESX Server, select Linux for the guest operating system and Open Enterprise Server for the
version.

Consider these support and configuration issues for SUSE Linux Enterprise Server 9:

Only the LSI Logic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 9 virtual machine
with more than 4GB of memory on ESX Server 3.x and 4.x.

Installation Steps

1
2
3

7
8

Insert the SLES 9 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SLES 9.

Install using the text mode installer. In the first installation screen, use the arrow keys to select
Installation, enter the boot option textmode=1, and then press Enter to select the text mode installer.

At the Installation Settings screen, go to the Change menu and select Booting.
The Boot Loader Setup screen appears.
Set the Boot Loader Type to GRUB.

The installer displays a warning that indicates you might lose some settings and prompts you to select a
course of action. Select Convert current configuration and continue.

Select Finish to return to the Installation Settings screen.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SLES 9 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux Enterprise Server 8

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 8 in a virtual machine is to use the standard
SUSE distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux Enterprise Server 8 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 8:

Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux Enterprise Server 8:

Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux Enterprise Server 8 virtual machine
on ESX Server 2.5.x. The LSI Logic virtual SCSI adapter is supported for SUSE Linux Enterprise Server 8
virtual machines on ESX Server 3.x. and 4.x. Only the LSI Logic virtual SCSI adapter is supported in a
SUSE Linux Enterprise Server 9 virtual machine with more than 4GB of memory on ESX Server 3.x and
4.x.

Installation Steps

1
2
3

5
6

Insert the SLES 8 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SLES 8.

Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

Part way through the installation, the installer reboots the virtual machine. At the LILO screen, let the boot
proceed using the default selection of linux.

At the Desktop Settings screen, select 640x480 256 colors.

Finish installing SLES 8 as you would on a physical machine.

This completes basic installation of the SLES 8 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

VMware, Inc.
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SUSE Linux Enterprise Server 7

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux Enterprise Server 7 (SLES 7) in a virtual machine is to use the
standard SUSE distribution CDs. The notes below describe an installation using the standard distribution CD;
however, installing SLES 7 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux Enterprise Server 7:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux Enterprise Server 7:

B During the SUSE Linux Enterprise Server 7 installation, a standard VGA16 X server should be installed.
To get an accelerated SVGA X server running inside the virtual machine, install the VMware Tools
package immediately after installing SUSE Linux Enterprise Server 7.

Installation Steps
1 Insert the SLES 7 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SLES 7.

3 Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

4  Part way through the installation, the installer reboots the virtual machine. At the LILO screen, let the boot
proceed using the default selection of linux.

5 At the Desktop Settings screen, select 640x480 256 colors.
6  Finish installing SLES 7 as you would on a physical machine.

This completes basic installation of the SLES 7 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Open SUSE Linux 11.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Open SUSE Linux 11.1 in a virtual machine is to use the standard Open SUSE
Linux distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing Open SUSE Linux 11.1 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Open SUSE Linux 11.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Open SUSE Linux 11.1:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Open SUSE Linux 11.1 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Open SUSE Linux 11.1.

3 Install using the text mode installer. In the first installation screen, press the F3 key to get boot options.
Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text
mode installer.

4  Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE
Linux 11.

At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu,
choose RPM Groups. Choose the Development group, press Enter to open it, and add gec, gec-c++, and
kernel-source by highlighting those items in the list and pressing the spacebar.

5 At the Test Internet Connection screen—during final configuration, after all packages are installed —do
not perform the Internet connection test.

6  Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Open SUSE Linux 11.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

To uninstall open-vm-tools provided by the OpenSUSE 11.1 distribution, see knowledge base article
http://kb.vmware.com/kb/1013096.
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Open SUSE Linux 10.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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The easiest method of installing Open SUSE Linux 10.3 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing Open SUSE Linux 10.3 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Open SUSE Linux 10.3:

Create and configure a new virtual machine.

Consider these support and configuration issues for Open SUSE Linux 10.3:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

6

Insert the Open SUSE Linux 10.3 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing Open SUSE Linux 10.3.

Install using the text mode installer. In the first installation screen, press the F3 key to get boot options.
Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text
mode installer.

Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE
Linux 10.

At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu,
choose RPM Groups. Choose the Development group, press Enter to open it, and add gec, gec-c++, and
kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen—during final configuration, after all packages are installed —do
not perform the Internet connection test.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Open SUSE Linux 10.3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Open SUSE Linux 10.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Open SUSE Linux 10.2 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing Open SUSE Linux 10.2 via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Open SUSE Linux 10.2:

Create and configure a new virtual machine.

Consider these support and configuration issues for Open SUSE Linux 10.2:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

6

Insert the Open SUSE Linux 10.2 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing Open SUSE Linux 10.2.

Install using the text mode installer. In the first installation screen, press the F3 key to get boot options.
Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text
mode installer.

Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE
Linux 10.

At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu,
choose RPM Groups. Choose the Development group, press Enter to open it, and add gec, gec-c++, and
kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen—during final configuration, after all packages are installed —do
not perform the Internet connection test.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the Open SUSE Linux 10.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 10.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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The easiest method of installing SUSE Linux 10.1 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 10.1 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 10.1:

Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 10.1:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

6

Insert the SUSE Linux 10.1 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SUSE Linux 10.1.

Install using the text mode installer. In the first installation screen, press the F3 key to get boot options.
Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text
mode installer.

Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE
Linux 10.

At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu,
choose RPM Groups. Choose the Development group, press Enter to open it, and add gec, gec-c++, and
kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen—during final configuration, after all packages are installed —do
not perform the Internet connection test.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 10.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 10 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 10 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 10:

Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 10:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

6

Insert the SUSE Linux 10 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SUSE Linux 10.

Install using the text mode installer. In the first installation screen, press the F3 key to get boot options.
Press the F3 key again and use the arrow keys to select text mode, and then press Enter to select the text
mode installer.

Be sure to install gcc and the kernel source so the VMware Tools installer can compile modules for SUSE
Linux 10.

At the Installation Settings screen, choose Change, and then choose Software. From the Filter menu,
choose RPM Groups. Choose the Development group, press Enter to open it, and add gec, gec-c++, and
kernel-source by highlighting those items in the list and pressing the spacebar.

At the Test Internet Connection screen—during final configuration, after all packages are installed —do
not perform the Internet connection test.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 10 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 9.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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The easiest method of installing SUSE Linux 9.3 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 9.3 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.3:

Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.3:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Only the BusLogic virtual SCSI adapter is supported in a SUSE Linux 9.3 virtual machine on ESX Server
2.5.x.

Installation Steps

1
2
3

4
5

Insert the SUSE Linux 9.3 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SUSE Linux 9.3.

Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode, and then press Enter to select the text mode installer.

During final configuration, after all packages are installed, do not perform the Internet connection test.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.3 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 9.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 9.2 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 9.2 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.2:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 9.2:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the SUSE Linux 9.2 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 9.2.

3 Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode, and then press Enter to select the text mode installer.

4 During final configuration, after all packages are installed, do not perform the Internet connection test.
5 Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 9.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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The easiest method of installing SUSE Linux 9.1 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 9.1 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.1:

Create and configure a new virtual machine.

Consider these support and configuration issues for SUSE Linux 9.1:

With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. Unless you are using ESX Server 2.5.x,
VMware recommends that you use the LSI Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1
2
3

4

Insert the SUSE Linux 9.1 installation CD in the CD-ROM drive.
Power on the virtual machine to start installing SUSE Linux 9.1.

Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode, and then press Enter to select the text mode installer.

Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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SUSE Linux 9.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 9.0 in a virtual machine is to use the standard SUSE Linux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing SUSE Linux 9.0 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 9.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 9.0:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the SUSE Linux 9.0 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 9.0.

3  Install using the text mode installer. In the first installation screen, press the F2 key, use the arrow keys to
select text mode, and then press Enter to select the text mode installer.

4  Follow the remaining installation steps as you would for a physical machine.

This completes basic installation of the SUSE Linux 9.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 9.0 virtual machine with any of the selections offered
in GRUB.
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SUSE Linux 8.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 8.2 in a virtual machine is to use the standard SUSE distribution
CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE
Linux 8.2 via the boot floppy/network method is supported as well. If your VMware product supports it, you
can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.2:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 8.2:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the SUSE Linux 8.2 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 8.2.

Installation Steps
1 Insert the SUSE Linux 8.2 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 8.2.

3  Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

4  Install using the text mode installer. In the first installation screen, press the F2 key, type 1inux, and then
press Enter to select the text mode installer.

5  When prompted, do not install an X server. In the Configure Monitor screen, choose Text Mode Only.
Click Accept and finish the installation.

This completes basic installation of the SUSE Linux 8.2 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 8.2 virtual machine with any of the selections offered
in GRUB.
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SUSE Linux 8.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 8.1 in a virtual machine is to use the standard SUSE distribution
CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE
Linux 8.1 via the boot floppy/network method is supported as well. If your VMware product supports it, you
can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 8.1:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the SUSE Linux 8.1 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 8.1.

Installation Steps
1 Insert the SUSE Linux 8.1 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 8.1.

3  Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

4  Install using the text mode installer. In the first installation screen, press the F2 key, and then press Enter
to select the text mode installer.

5  When prompted, do not install an X server. In the Configure Monitor screen, choose Text Mode Only.
Click Accept and finish the installation.

This completes basic installation of the SUSE Linux 8.1 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as the root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE Linux 8.1 virtual machine with any of the selections offered
in GRUB.
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SUSE Linux 8.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 8.0 in a virtual machine is to use the standard SUSE distribution
CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE
Linux 8.0 via the boot floppy/network method is supported as well. If your VMware product supports it, you
can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 8.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 8.0:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the SUSE Linux 8.0 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 8.0.

Installation Steps
1 Insert the SUSE Linux 8.0 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 8.0.

3  Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

4  Install using the text mode installer.

5  When prompted, do not install an X server. In the Configure Monitor screen, choose No X11. The installer
asks you to confirm. Click Continue and finish the installation.

This completes basic installation of the SUSE Linux 8.0 guest operating system.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.

After you have installed VMware Tools, but before you start the X server, as root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2 you can boot your SUSE 8.0 virtual machine with any of the selections offered in LILO.
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SUSE Linux 7.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing SUSE Linux 7.3 in a virtual machine is to use the standard SUSE distribution
CDs. The notes below describe an installation using the standard distribution CD; however, installing SUSE
Linux 7.3 via the boot floppy/network method is supported as well. If your VMware product supports it, you
can also install from a PXE server.

Fulfill these requirements before you install SUSE Linux 7.3:
B Create and configure a new virtual machine.
Consider these support and configuration issues for SUSE Linux 7.3:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the SUSE Linux 7.3 installation, do not install an X server. To get an accelerated SVGA X server
running inside the virtual machine, install the VMware Tools package immediately after installing SUSE
Linux 7.3.

Installation Steps
1 Insert the SUSE Linux 7.3 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing SUSE Linux 7.3.

3  Follow the installation steps as you would for a physical machine until you get to the selection screens
described in the next steps.

4  Install using the text mode installer.

5  When prompted, do not install an X server. In the Configure Monitor screen, choose No X11. The installer
asks you to confirm. Click Continue and finish the installation.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, you can boot your SUSE 7.3 virtual machine with any of the selections
offered in LILO.
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Turbolinux 10 Server

General Installation Notes

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Turbolinux 10 Server in a virtual machine is to use the standard Turbolinux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing Turbolinux 10 Server via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 10 Server:
®  Create and configure a new virtual machine.
Consider these support and configuration issues for Turbolinux 10 Server:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Turbolinux 10 Server installation CD in the CD-ROM drive.

2 Power on the virtual machine to start installing Turbolinux 10 Server.

3 Follow the installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Turbolinux 10 Desktop

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Turbolinux 10 Desktop in a virtual machine is to use the standard Turbolinux
distribution CDs. The notes below describe an installation using the standard distribution CD; however,
installing Turbolinux 10 Desktop via the boot floppy/network method is supported as well. If your VMware
product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 10 Desktop:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Turbolinux 10 Desktop:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Turbolinux 10 Desktop installation CD in the CD-ROM drive.

2 Power on the virtual machine to start installing Turbolinux 10 Desktop.

3  Follow the installation steps as you would for a physical machine.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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Turbolinux Enterprise Server 8

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Turbolinux Enterprise Server 8 in a virtual machine is to use the standard
Turbolinux distribution CDs. The notes below describe an installation using the standard distribution CD;
however, installing Turbolinux Enterprise Server 8 via the boot floppy/network method is supported as well.
If your VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux Enterprise Server 8:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Turbolinux Enterprise Server 8:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the Turbolinux Enterprise Server 8 installation, do not install an X server. To get an accelerated
SVGA X server running inside the virtual machine, install the VMware Tools package immediately after
installing Turbolinux Enterprise Server 8.

Installation Steps
1  Insert the Turbolinux Enterprise Server 8 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Turbolinux Enterprise Server 8.

3  Follow the installation steps as you would for a physical machine, until you get to the selection screens
described in the next steps.

4  Install using the text mode installer. In the first installation screen, press the F2 key, and then press Enter
to select the text mode installer.

5  When prompted, do not install an X server. In the Desktop Settings screen, choose Text Mode Only. Click
Accept and finish the installation.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine using the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2, you can boot your Turbo Linux Enterprise Server 8 virtual machine with any of the
selections offered in GRUB.
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Turbolinux Workstation 8

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Turbolinux Workstation 8 in a virtual machine is to use the standard
Turbolinux distribution CDs. The notes below describe an installation using the standard distribution CD;
however, installing Turbolinux Workstation 8 via the boot floppy/network method is supported as well. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux Workstation 8:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Turbolinux Workstation 8:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the Turbolinux Workstation 8 installation, do not install an X server. To get an accelerated SVGA
X server running inside the virtual machine, install the VMware Tools package immediately after
installing Turbolinux Workstation 8.

Installation Steps
1 Insert the Turbolinux Workstation 8 installation CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Turbolinux Workstation 8.

3 Follow the installation steps as you would for a physical machine, until you get to the selection screens
described in the next steps.

4  Install using the text mode installer. In the first installation screen, press the F2 key, and then press Enter
to select the text mode installer.

5  When prompted, do not install an X server. In the Desktop Settings screen, choose Text Mode Only. Click
Accept and finish the installation.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

After you have installed VMware Tools, but before you start the X server, as root user, run the SaX2
configuration utility to configure your X server. At a command prompt, type SaX2 and use the wizard to
configure your X server. If you intend to connect to this virtual machine with the VMware Virtual Machine
Console, configure the color resolution for 65536 (16-bit) colors or less.

After you run SaX2, you can boot your Turbolinux Workstation 8 virtual machine with any of the selections
offered in GRUB.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Turbolinux 7.0 in a virtual machine is to use the standard Turbolinux 7.0
distribution CD. The notes below describe an installation using the standard distribution CD; however,
installing Turbolinux 7.0 via the boot floppy/network method is supported as well. If your VMware product
supports it, you can also install from a PXE server.

Fulfill these requirements before you install Turbolinux 7.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Turbolinux 7.0:

®  With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B During the Turbolinux 7.0 installation, a standard VGA16 X server (without support for the VMware
display adapter) is installed. To get an accelerated SVGA X server running inside the virtual machine,
install the VMware Tools package immediately after installing Turbolinux 7.0, before you start the X
server.

Installation Steps

1 Insert the Turbolinux 7.0 CD No. 1 in the CD-ROM drive.
2 Power on the virtual machine to start installing Turbolinux 7.0.

3  Follow the installation steps as you would for a physical PC until you get to the selection screen described
in the next step.

4 In the Configure Monitor screen, follow the defaults to configure an X server. This is necessary even
though you will install a different X server with VMware Tools after you finish installing the guest
operating system.

5  Finish installing Turbolinux 7.0 as you would on a physical computer.

At this point Turbolinux 7.0 boots and a login screen appears.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Do not start the X server in the guest operating system until you install VMware Tools.
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Ubuntu 9.04

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu 9.04 in a virtual machine is to use the standard Ubuntu 9.04
distribution CD.

Fulfill these requirements before you install Ubuntu 9.04:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu 9.04:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Ubuntu 9.04 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu 9.04.

3 After the Ubuntu 9.04 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Ubuntu 9.04 user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE For Ubuntu 9.04, install VMware Tools using the tar installer.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu

Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.

[6M)

Select System > Administration > Users and Groups and click Unlock.
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4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu 8.10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu 8.10 in a virtual machine is to use the standard Ubuntu 8.10
distribution CD.

Fulfill these requirements before you install Ubuntu 8.10:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu 8.10:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1  Insert the Ubuntu 8.10 CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu 8.10.

3 After the Ubuntu 8.10 installer copies the files it needs to the virtual disk, it ejects the installation CD and
displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Ubuntu 8.10 user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE For Ubuntu 8.10, install VMware Tools using the tar installer.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu

Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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Select System > Administration > Users and Groups and click Unlock.
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4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu 8.04 LTS

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu 8.04 LTS in a virtual machine is to use the standard Ubuntu 8.04 LTS
distribution CD.

Fulfill these requirements before you install Ubuntu 8.04 LTS:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu 8.04 LTS:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu 8.04 LTS CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu 8.04 LTS.

3 After the Ubuntu 8.04 LTS installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Ubuntu 8.04 LTS user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE For Ubuntu 8.04 LTS, 8.04.1, and 8.04.2, you can install VMware Tools using the tar installer or the
appropriate OSP. For a complete set of instructions for downloading, installing, and upgrading VMware Tools
OSPs, see the VMware Tools Installation Guide Operating System Specific Packages at:
http://www.vmware.com/pdf/osp_install_guide.pdf

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu
Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.
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Ubuntu Desktop Edition

1
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Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.

Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu Linux 7.10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 7.10 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 7.10:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 7.10:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, in the Ubuntu Linux user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

To enable root in a virtual machine running Ubuntu Linux

Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.

2 Select the Allow local system administrator login check box and click Close.
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Select System > Administration > Users and Groups and click Unlock.

VMware, Inc. 119


http://kb.vmware.com/kb/340

Guest Operating System Installation Guide

4 In the Authenticate window, type your password and click Authenticate.

5  Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu Linux 7.04

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 7.04 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 7.04:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 7.04:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

NOTE As the installation progresses, the message Configuring apt/ Scanning the mirror appears
indicating that the network is being scanned. If your site uses an HTTP proxy, this message might persist for
10 minutes or longer, indicating that the installation has been delayed. If you wait, network scanning
eventually stops and the installation resumes. When the installation completes, from the Ubuntu Linux user
interface, choose System > Preferences > Network Proxy to set the HTTP proxy in the Network Proxy
Preferences dialog box.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

Ubuntu Server Edition

1  Open a terminal window and log in as a normal user.

2 Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu Linux 6.10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 6.10 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 6.10:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 6.10:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.

62 B N S S

Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu Linux 6.06

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 6.06 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 6.06:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 6.06:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest. You can
complete the following steps either before or during the VMware Tools installation.

Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.
Select the Allow local system administrator login check box and click Close.
Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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Ubuntu Linux 5.10
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 5.10 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 5.10:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 5.10:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 After the Ubuntu Linux installer copies the files it needs to the virtual disk, it ejects the installation CD
and displays a message indicating that the computer will restart. If the virtual machine fails to restart as
expected, click the Reset button to restart it.

4  Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest.
Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3 Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.

Select the Allow local system administrator login check box and click Close.

Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.

VMware Tools and 64-bit Version of Ubuntu Linux 5.10

The 64-bit version of Ubuntu Linux 5.10 lacks the driver needed for correct operation of the X server in the
virtual machine. The driver is installed when you install VMware Tools. To install VMware Tools in the 64-bit
version of Ubuntu Linux 5.10, see knowledge base article at http://kb.vmware.com/kb/1900.
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Ubuntu Linux 5.04

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing Ubuntu Linux 5.04 in a virtual machine is to use the standard Ubuntu Linux
distribution CD.

Fulfill these requirements before you install Ubuntu Linux 5.04:
B Create and configure a new virtual machine.
Consider these support and configuration issues for Ubuntu Linux 5.04:

B With many Linux guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the Ubuntu Linux CD in the CD-ROM drive.
2 Power on the virtual machine to start installing Ubuntu Linux.

3 If your host computer is on a network that uses a proxy server for Internet access, enter information about
the proxy server name and port at the boot prompt.

linux http_proxy=http://<proxy_server>:<port_number>
4  Follow the installation steps as you would for a physical PC.

You can now become root at any time using the normal su — command and the root password you just
created.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE You must use the tar installer to install VMware Tools in Ubuntu Linux.

To install VMware Tools using the tar installer, you need to enable root in your Ubuntu guest.
Ubuntu Server Edition

1  Open a terminal window.

2 Login as a normal user.

3  Type sudo passwd root to set a root password.

Ubuntu Desktop Edition

1  Select System > Administration > Login Window, and click the Security tab.

Select the Allow local system administrator login check box and click Close.

Select System > Administration > Users and Groups and click Unlock.

In the Authenticate window, type your password and click Authenticate.
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Select root, click Properties, and under Set password by hand, establish a root password.
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FreeBSD 7.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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You can install FreeBSD 7.1 from a DVD or CDs.

Fulfill these requirements before you install FreeBSD 7.1:

Create and configure a new virtual machine.
Download the ISO images from the FreeBSD Web site:
http://www.freebsd.org/doc/en_US.ISO8859-1/books/handbook/mirrors-ftp.html
The ISO images are located in the /ISO-IMAGES/7.1 directory:
B 32-bit - ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/i386/ISO-IMAGES/7.1
B 7.1-RELEASE-i386-bootonly.iso
®  7.1-RELEASE-1386-discl.iso
®  7.1-RELEASE-1386-disc2.iso
m  7.1-RELEASE-i386-dvdl.iso.gz
B 64-bit - ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/amd64/ISO-IMAGES/7.1
B 7.1-RELEASE-amd64-bootonly.iso
®  7.1-RELEASE-amd64-discl.iso
®  7.1-RELEASE-amd64-disc2.iso
®  7.1-RELEASE-amd64-disc3.iso
m  7.1-RELEASE-amd64-dvdl.iso.gz

The discl.iso file contains the base FreeBSD system and a few prebuilt packages. The disc2.iso and
disc3.1iso files contain more prebuilt packages. The dvdl.iso.gz file is DVD-sized and includes everything
that is on the CD-ROM disks.

The bootonly.1iso for the FreeBSD install CD-ROM executes the sysinstall application. The sysinstall
application is the required to initially install FreeBSD 7.1 on the hard drive.

Consider these support and configuration issues for FreeBSD 7.1:

With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI

Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 7.1:
1  Insert the FreeBSD 7.1 32-bit or FreeBSD 64-bit CD or DVD into the CD-ROM drive.
2 Power on the guest.
3 Use the sysinstall utility, select the standard, custom, or express install method.
4 Use the sysinstall utility to create a partition.

You can use Disklabel to automatically create partitions and assign default sizes.
5  Accept the changes.
6  Choose the distributions, for example, X-kernel developer, normal user, and so on.
7 Select CD or DVD for the media.
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8 Ifyou selected CD, insert the appropriate CD when prompted. (If you selected DVD, the installation will
not prompt for additional DVDs.)

9  Configure the system devices, components, and so on for the guest.

10 Reboot the guest when the installation completes.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 7.0

Be sure to read and this section before installing this operating system.

The easiest method of installing FreeBSD 7.0 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 7.0:
®  Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 7.0:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 6.4

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install FreeBSD 6.4 from a DVD or CDs.

Fulfill these requirements before you install FreeBSD 6.4:

Create and configure a new virtual machine.
Download the ISO images from the FreeBSD Web site:
http://www.freebsd.org/doc/en_US.ISO8859-1/books/handbook/mirrors-ftp.html
The ISO images are located in the /ISO-IMAGES/6.4 directory:
B 32-bit — ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/i386/ISO-IMAGES/6.4
B 6.4-RELEASE-i386-bootonly.iso
B 6.4-RELEASE-1386-discl.iso
B 6.4-RELEASE-1386-disc2.iso
B 6.4-RELEASE-1386-disc3.iso
B 6.4-RELEASE-i386-dvdl.iso.gz
B 64-bit — ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/amd64/ISO-IMAGES/6.4
B 6.4-RELEASE-amd64-bootonly.iso
B 6.4-RELEASE-amd64-discl.iso
B 6.4-RELEASE-amd64-disc2.iso
B 6.4-RELEASE-amd64-disc3.iso

B 6.4-RELEASE-amd64-dvdl.iso.gz

The discl.iso file contains the base FreeBSD 6.4 operating system and a few pre-built packages. The
disc2.isoand disc3.1iso files contain additional pre-built packages. The dvdl.iso.gz file is DVD-sized and
includes everything that is on the CD-ROM disks.

Thebootonly.iso from the FreeBSD install CD-ROM executes the sysinstall application. The sysinstall
application is required to initially install FreeBSD on your hard drive.

Consider these support and configuration issues for FreeBSD 6.4:

With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 6.4:
1 Insert the FreeBSD 6.4 32-bit or FreeBSD 6.4 64-bit CD or DVD into the CD-ROM drive.
2 Power on the guest.
3 Use the sysinstall utility, select the standard, custom, or express install method.
4  Use the sysinstall utility to create a partition.
You can use Disklabel to automatically create partitions and assign default sizes.
5  Accept the changes.
6  Choose the Distributions, for example, X-kernel developer, normal user, and so on.
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7  Select CD or DVD for the media.

8 If you selected CD, insert the appropriate CD when prompted. (If you selected DVD, the guest will not
prompt for additional DVDs.)

9  Configure the system devices, components, and so on for the guest.

10 Reboot the guest when the installation completes.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 6.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install FreeBSD 6.3 from a DVD or CDs.

Fulfill these requirements before you install FreeBSD 6.3:

Create and configure a new virtual machine.
Download the ISO images from the FreeBSD Web site:
http://www.freebsd.org/doc/en_US.ISO8859-1/books/handbook/mirrors-ftp.html
The ISO images are located in the /ISO-IMAGES/6. 3 directory:
B 32-bit — ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/i386/ISO-IMAGES/6.3
B 6.3-RELEASE-i386-bootonly.iso
B 6.3-RELEASE-1386-discl.iso
B 6.3-RELEASE-1386-disc2.iso
B 6.3-RELEASE-1386-disc3.iso
®  6.3-RELEASE-i386-dvdl.iso.gz
B 64-bit — ftp://ftp5.FreeBSD.org/pub/FreeBSD/releases/amd64/ISO-IMAGES/6.3
B 6.3-RELEASE-amd64-bootonly.iso
B 6.3-RELEASE-amd64-discl.iso
B 6.3-RELEASE-amd64-disc2.iso
B 6.3-RELEASE-amd64-disc3.iso
B 6.3-RELEASE-amd64-dvdl.iso.gz

The discl.iso file contains the base FreeBSD 6.3 operating system and a few pre-built packages. The
disc2.isoand disc3.iso files contain additional pre-built packages. The dvd1. iso.gz file is DVD-sized and
includes everything that is on the CD-ROM disks.

The bootonly.iso from the FreeBSD install CD-ROM executes the sysinstall application. The sysinstall
application is the required to initially install FreeBSD on your hard drive.

Consider these support and configuration issues for FreeBSD 6.3:

With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps

To install FreeBSD 6.3:
1 Insert the FreeBSD 6.3 32-bit or FreeBSD 6.3 64-bit CD or DVD into the CD-ROM drive.
2 Power on the guest.
3 Use the sysinstall utility, select the standard, custom, or express install method.
4  Use the sysinstall utility to create a partition.
You can use Disklabel to automatically create partitions and assign default sizes.
5  Accept the changes.
6  Choose the Distributions, for example, X-kernel developer, normal user, and so on.
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7  Select CD or DVD for the media.

8 If you selected CD, insert the appropriate CD when prompted. (If you selected DVD, the guest will not
prompt for additional DVDs.)

9  Configure the system devices, components, and so on for the guest.

10 Reboot the guest when the installation completes.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 6.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 6.2 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 6.2:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 6.2:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 6.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 6.1 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 6.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 6.1:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 6.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 6.0.1 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 6.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 6.0:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

VMware, Inc. 135


http://kb.vmware.com/kb/340

Guest Operating System Installation Guide

FreeBSD 5.5

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 5.5 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 5.5:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 5.5:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 5.4

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 5.4 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 5.4:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 5.4:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 5.3

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 5.3 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 5.3:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 5.3:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 5.2

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before

installing this operating system.

Fulfill these requirements before you install FreeBSD 5.2:

®  Create and configure a new virtual machine.

Consider these support and configuration issues for FreeBSD 5.2:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.
2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 5.1

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 5.1 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 5.1:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 5.1:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 5.0

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 5.0 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 5.0:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 5.0:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 4.11

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 4.11 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 4.11:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 4.11:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

Installation Steps
1 Insert the FreeBSD CD in the CD-ROM drive.
2 Power on the virtual machine to start installing FreeBSD.

3 In the FreeBSD Disklabel Editor step, do not use the installer's default option A partitioning. Use option
C to create the mounts. In order to install VMware Tools, you need more space in /usr than is provided
by the installer's defaults. Be sure your partitioning scheme includes at least 4,000,000 blocks for /usr.

4  Follow the rest of the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 4.10

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 4.10 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 4.10:

Create and configure a new virtual machine.

Consider these support and configuration issues for FreeBSD 4.10:

With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

VMware recommends that you configure ESX Server virtual machines that use this guest operating
system to use the vinx Ethernet adapter. See your product documentation for instructions.

Installation Steps

1
2
3

Insert the FreeBSD CD in the CD-ROM drive.
Power on the virtual machine to start installing FreeBSD.

In the FreeBSD Disklabel Editor step, do not use the installer’s default option A partitioning. Use option
C to create the mounts. In order to install VMware Tools, you need more space in /usr than is provided
by the installer's defaults. Be sure your partitioning scheme includes at least 4,000,000 blocks for /usr.

Follow the rest of the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 4.9

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 4.9 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 4.9:

Create and configure a new virtual machine.

Consider these support and configuration issues for FreeBSD 4.9:

With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

VMware recommends that you configure ESX Server virtual machines that use this guest operating
system to use the vinx Ethernet adapter. See your product documentation for instructions.

Installation Steps

1
2
3

Insert the FreeBSD CD in the CD-ROM drive.
Power on the virtual machine to start installing FreeBSD.

In the FreeBSD Disklabel Editor step, do not use the installer’s default option A partitioning. Use option
C to create the mounts. In order to install VMware Tools, you need more space in /usr than is provided
by the installer's defaults. Be sure your partitioning scheme includes at least 4,000,000 blocks for /usr.

Follow the rest of the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 4.4, 4.5,4.6.2,4.8

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 4.4, 4.5, 4.6.2 or 4.8 in a virtual machine is to use the standard
FreeBSD distribution CD.

Fulfill these requirements before you install FreeBSD 4.4 through 4.8:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 4.4 through 4.8:

®  With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B FreeBSD 4.6 is not supported. Use FreeBSD 4.6.2 instead. It resolves an issue that interferes with
installation of FreeBSD 4.6 in a virtual machine.

Installation Steps
1  Insert the FreeBSD CD in the CD-ROM drive.

2 Power on the virtual machine to start installing FreeBSD.

3 Follow the installation steps as you would for a physical PC.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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FreeBSD 4.0, 4.1,4.2,4.3
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

The easiest method of installing FreeBSD 4.0, 4.1, 4.2 or 4.3 in a virtual machine is to use the standard FreeBSD
distribution CD.

Fulfill these requirements before you install FreeBSD 4.0 through 4.3:
B Create and configure a new virtual machine.
Consider these support and configuration issues for FreeBSD 4.0 through 4.3:

B With many FreeBSD guest operating systems, various problems have been observed when the BusLogic
virtual SCSI adapter is used with VMware virtual machines. VMware recommends that you use the LSI
Logic virtual SCSI adapter with this guest operating system.

B If you create your virtual machine with a virtual IDE disk, installation proceeds as it would on a physical
machine. If you create your virtual machine with a SCSI virtual disk that is 2GB or larger, see “Setting the
Disk Geometry for a FreeBSD SCSI Virtual Disk” on page 146

Installation Steps

1 Insert the FreeBSD CD in the CD-ROM drive.
2 Power on the virtual machine to start installing FreeBSD.

3  Follow the installation steps as you would for a physical PC.

Setting the Disk Geometry for a FreeBSD SCSI Virtual Disk

If you install FreeBSD 4.0, 4.1, 4.2 or 4.3 as the guest operating system on a 2GB or larger SCSI virtual disk, the
guest operating system does not boot unless you take the special steps described in this section.

It fails to boot because the virtual disk geometry is not probed correctly by FreeBSD when you install the guest
operating system. FreeBSD installs the boot loader in the wrong location on the virtual disk. When FreeBSD
tries to boot, the FreeBSD boot loader asks the BIOS for important data that is now on a different section of the
virtual disk, so FreeBSD cannot boot.

This problem has been fixed in FreeBSD 4.4. This and later versions correctly boot SCSI virtual disks of
any size.

To use FreeBSD 4.0, 4.1, 4.2 or 4.3 in your virtual machine, do one of two things:

B Use an IDE virtual disk in your virtual machine. You might need to add the IDE virtual disk to the virtual
machine with the Configuration Editor.

B Set the disk geometry by hand when installing FreeBSD. These steps are outlined below.

To set the disk geometry manually

1  FreeBSD calculates an incorrect disk geometry before you arrive at the FDISK Partition Editor, as
illustrated here.

Disk name: T [FDISK Partition Editor
B)

DISK Geometry: 2855 cyls/64 heads/32 sectors = 4288648 sectors (2855M

0 fset Size(ST) End Name PType Desc Subtype  Flags

a 4209038 4209829 = 6 unused [}

[The following commands are supported Cin upper or lower case):
= Use Entire Disk G = set Drive Geometry C = Create Slice
= Delete Slice Z = Toggle Size Units S = Set Bootable
= Change Type U = Undo All Changes Q = Finish

Use F1 or ? to get more help, arrow keys to select.
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To set the disk geometry, press G to select the option Set Drive Geometry. A dialog box appears,
containing numbers like 2055/64/32, representing the incorrect geometry in cylinders, heads and sectors
per head.

[Disk name: [iae} [FDISK Partition Editor]

DISK Geometry: 2855 cyls/64 heads/32 sectors = 4286648 sectors (26855MB)

01 fset Size(sT) End Name PType Desc Subtype  Flags

a 4289838 4209829 - [ unused [}

Please specify the mew georetry in cyl/hd/sect format.
Don't forget to use the two slash (/) separator characterst
It's not possible to parse the field without them.

12255/54/32|
The foll

L0k ] Cancel

il
D - Delete
T = Change Type U = Undo ALl Changes Q = Finish

Use F1 or 7 to get more help, arrow keys to select.

To calculate the correct geometry, find the total number of sectors by multiplying the number of cylinders,
heads and sectors per head together, and then dividing the number of sectors by the correct number of
heads and sectors per head.

In the above illustration, the virtual disk is a 2055MB disk with 2055 cylinders, 64 heads and 32 sectors per
head (these numbers represent the incorrect geometry). The product of these three numbers (2055 x 64 x
32) equals 4,208,640 sectors.

To determine the correct geometry for the BusLogic compatible virtual SCSI adapter used by the virtual
machine, calculate the number of cylinders, which is 4,208,640 sectors divided by the product of the actual
number of heads and sectors per head (255 heads times 63 sectors per head). This results in a total of 261
actual cylinders (4208640/(255 * 63) = 261, rounded down).

Disk name: [dag] [FDISKR Partition Editor]
IDISK Geometry: 2855 cyls-64 heads/32 sectors = 4288648 sectors (2855MB)

o1 £set Size(sT) End Nave PType Desc Subtype  Flags

[} 4289838 4209829 - 6 unused [}

Please specify the new geometry in cyl’hd/sect format.
Don’t forget to use the two slash (/) separator characterst
It's not possible to parse the field without them.

lzs 1,255/63]
[The o1l

[ ox ] Cancel

il
D - Delete
T - Change Type U = Undo A1l Changes Q = Finish

Use F1 or 7 to get more help, arrow keys to select.

You can now enter the correct geometry of 261 cylinders, 255 heads and 63 sectors per head by typing
261/255/63 in the dialog box. Then click OK and continue installing FreeBSD.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.
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NetWare 6.5 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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You can install NetWare 6.5 in a virtual machine using the standard Novell NetWare 6.5 Operating System and
Product CD-ROMs.

Fulfill these requirements before you install NetWare 6.5 Server:

Create and configure a new virtual machine.

When you create a virtual machine for NetWare 6.5 with Novell Open Enterprise Server on an ESX Server,
select Novell NetWare for the guest operating system and Novell NetWare 6.x for the version.

Consider these support and configuration issues for NetWare 6.5:

VMware recommends you install NetWare 6.5 on a computer with at least 512MB of memory.

Guests without Support Pack 1: Read the Novell technical information document at
support.novell.com/cgi-bin/search/searchtid.cgi?/2967370.htm. This document describes the steps
necessary to download and install a NetWare patch required when you install a NetWare 6.5 Server guest
operating system without SP1.

When you configure a virtual machine for a NetWare 6.5 guest, use the virtual LSI Logic SCSI adapter.
NetWare 6.5 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1
2
3

Insert the Novell NetWare 6.5 Product CD in the CD-ROM drive.
Power on the virtual machine to start installing NetWare 6.5.

Read and accept the license agreement.

NOTE A few prompts appear before you reach the license agreement. Accept the defaults for installing
NetWare, the CD-ROM drive type, how to restore the floppy drive and the run mode, and then continue.

When prompted, choose IDE CD-ROM.
Create a new boot partition. The guest operating system reboots. The installation continues.
VMware ESX Server: Jump to Step 7.

VMware Workstation, VMware ACE and VMware GSX Server: To configure IP networking, do one of
the following:

®  If you chose bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. Lan), it fails because it broadcasts for its
own IP address. This causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type
set allow ip address duplicates=on
Press Alt+Esc to return to the installation.
®  If you chose host-only networking for the virtual machine, look up the host machine’s IP address.
At a command prompt on a Windows host, type
ipconfig /all
At a command prompt on a Linux host, type

ifconfig
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Note the host’s IP address for VMnet1 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.4##,
where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the host’s IP address (192.168.160.1 in our example).

®  If you chose network address translation (NAT) for the virtual machine, look up the host machine’s
IP address.

At a command prompt on a Windows host, type
ipconfig /all

At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.4##,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the NAT service’s IP address (192.168.160.2 in our example).
Note that with Network Address Translation, there are 2 IP addresses in use on the host:

B The IP address assigned to the interface for VMnet8 (which shows up in the ipconfig output
with a ".1" in the last octet).

B The IP address used by the NAT device itself (which always uses ".2" as the last octet).
7 Finish the installation by following the on-screen instructions.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
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Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install NetWare 6.0 in a virtual machine using the standard Novell NetWare 6.0 CD-ROM.
Fulfill these requirements before you install NetWare 6.0 Server:

®  Create and configure a new virtual machine.

Consider these support and configuration issues for NetWare 6.0 Server:

B VMware recommends you install NetWare 6 on a computer with at least 256MB of memory.

B In the NetWare installation process, you must boot from the installation CD twice—once to format the
virtual machine's disk drive, and then a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message
No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears,
press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.

B When you configure a virtual machine for a NetWare 6.0 guest, use the virtual LSI Logic SCSI adapter.
NetWare 6.0 does not include a driver for the virtual BusLogic SCSI adapter.

Installation Steps

1 Insert the NetWare 6.0 Server CD in the CD-ROM drive.
Power on the virtual machine to start installing NetWare 6.0.
Read and accept the license agreement.
When prompted, choose IDE CD-ROM.

Create a new boot partition. The guest operating system reboots.

(o) NG B L B S

To configure IP networking, do one of the following:
®  If you chose bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. Lan), it fails because it broadcasts for its
own IP address. This causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type
set allow ip address duplicates=on
Press Alt+Esc to return to the installation.
®m  If you chose host-only networking for the virtual machine, look up the host machine's IP address.
At a command prompt on a Windows host, type
ipconfig /all
At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnetl and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.4##,
where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.
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For the router gateway, enter the host’s IP address (192.168.160.1 in this example).

If you chose network address translation (NAT) for the virtual machine, look up the host machine's
IP address.

At a command prompt on a Windows host, type
ipconfig /all

At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the NAT service’s IP address (192.168.160.2 in this example).
Note that with Network Address Translation, there are two IP addresses in use on the host:

®  The IP address assigned to the interface for VMnet8 appears in the ipconfig output witha1in
the last octet.

®  The IP address used by the NAT device itself always uses 2 as the last octet.

Finish the installation.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
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NetWare 5.1 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.
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You can install NetWare 5.1 Server in a virtual machine using the standard Novell NetWare 5.1 Server
CD-ROM.

Fulfill these requirements before you install NetWare 5.1 Server:

Create and configure a new virtual machine.

Consider these support and configuration issues for NetWare 5.1 Server:

VMware recommends you install NetWare 5.1 on a computer with at least 256MB of memory.

If you are running NetWare 5.1 Server Support Pack 6, you should install the latest LSI Logic SCSI driver.
For information on obtaining and installing the driver, see http://kb.vmware.com/kb/1181.

For SCSI support, be sure to download the latest LSI Logic driver.

In the NetWare installation process, boot from the installation CD twice—once to format the virtual
machine's disk drive, and a second time to install files from the CD.

On the reboot, you see the message Operating System not found and a dialog box with the message
No bootable CD, floppy or hard disk was detected.

To boot from the CD the second time, change the boot order.

As the virtual machine boots, click inside the virtual machine window. When the VMware logo appears,
press Esc. Use the arrow keys to select the CD drive as the boot device, and then press Enter.

Installation Steps

1
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Insert the NetWare 5.1 Server CD into the CD-ROM drive.

Power on the virtual machine to start installing NetWare 5.1.

Read and accept the license agreement.

Create a new boot partition. The guest operating system reboots. The installation continues.
VMware ESX Server: Skip to Step 6.

VMware Workstation, VMware ACE and VMware GSX Server: To configure IP networking, do one of
the following:

®  If you chose bridged networking for the virtual machine, enter its IP address.

When NetWare tries to load the LAN driver (using pcntnw. Lan), it fails because it broadcasts for its
own IP address. This causes IP networking to fail.

To work around this, open the System Console (press Ctrl+Esc) and type
set allow ip address duplicates=on
Press Alt+Esc to return to the installation.
®m  If you chose host-only networking for the virtual machine, look up the host machine's IP address.
At a command prompt on a Windows host, type
ipconfig /all
At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnetl and change the last octet so it is greater than the last octet in
the IP address of the host.
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For example, if the host IP address is 192.168.160.1, and then the virtual machine’s IP address is
192.168.160.###, where ### is any number greater than 1 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the host’s IP address (192.168.160.1 in this example).

If you chose network address translation (NAT) for the virtual machine, look up the host machine's
IP address.

At a command prompt on a Windows host, type
ipconfig /all

At a command prompt on a Linux host, type
ifconfig

Note the host’s IP address for VMnet8 and change the last octet so it is greater than the last octet in
the IP address of the host.

For example, if the host IP address is 192.168.160.1, the virtual machine’s IP address is 192.168.160.###,
where ### is any number greater than 2 and less than 128.

For the subnet mask, enter 255.255.255.0.
For the router gateway, enter the NAT service’s IP address (192.168.160.2 in this example).
Note that with Network Address Translation, there are two IP addresses in use on the host:

®  The IP address assigned to the interface for VMnet8 shows up in the ipconfig output with a1
in the last octet.

®  The IP address used by the NAT device itself always uses 2 as the last octet.

Finish the installation by following the on-screen instructions.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of

whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
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NetWare 4.2 Server

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

You can install NetWare 4.2 Server in a virtual machine using the standard Novell NetWare 4.2 Server
installation CD.

Fulfill these requirements before you install NetWare 4.2 Server:
B Create and configure a new virtual machine.
®m  If you created this virtual machine on a Linux host follow these steps:
a  Open the configuration file (<netware>. cfg) in a text editor and add the following line:
gui.iconLEDS = false

b This removes all the LED icons in the console window, which prevents the virtual machine display
from appearing incorrectly when you power it on while the host is in 8 bit/256 color mode.

¢ Install the guest operating system and VMware Tools, which includes the CPU idler program. See
“VMware Tools” on page 155

Consider these support and configuration issues NetWare 4.2 Server:

B VMware recommends you install NetWare 4.2 Server on a host with at least 256MB of memory.

Installation Steps

1 VMware recommends that you install MS-DOS 5.0 or higher in a small (50MB FAT16) partition as
described in these guidelines. The rest of the free space on the virtual disk is used for the NetWare
partition. Even if the virtual machine is to run NetWare most of the time, it is a good idea to install a CPU
idler program.

2 Install a CD-ROM driver or CD-ROM software for MS-DOS. If you have problems setting up the MS-DOS
virtual machine to access the CD-ROM drive, you can use the mtmcdai.sys driver, which can be found
at www.mitsumi.com. Under Drivers and Manuals look for ide158. exe.

3 Modify the config.sys and autoexec.bat files on your MS-DOS boot floppy (along with the
mscdex. exe file) as shown below. If you are using a MS-DOS boot partition, adjust the drive letters
accordingly.

config.sys

device=himem.sys /testmem:off
device=NEC_IDE.SYS /D:MSCD0O1
files=12

buffers=15

stacks=9,256

lastdrive=z

autoexec.bat
@ECHO OFF

set EXPAND=YES
SET DIRCMD=/0:N
cls

set temp=c:\
set tmp=c:\
path=c:\

IF "%config%"=="NOCD" GOTO QUIT
a:\NWCDEX.EXE /D:mscd001

:QUIT

After you have configured the CD-ROM software, verify that the virtual machine can read a CD from the
host system’s CD-ROM drive.
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4 If the virtual machine is not running, power it on and wait for MS-DOS to finish its boot process.

5 Insert the NetWare 4.2 CD in the CD-ROM drive on the GSX Server host.

6  In the virtual machine, at the MS-DOS prompt, run fdisk to create a partition for NetWare.
A:\>fdisk

7 After you create the partition, reboot the virtual machine. Press Ctrl+Alt+Insert.

8 Format the C: drive. Type the following:
format c: /s /x

9  Copy the following files to your C: drive from your floppy. Type the following;:

Copy autoexec.bat c:
Copy config.sys c:
Copy himem.sys c:
Copy nwcdex.exe c:
Copy nec_ide.sys c:

10 Modify the autoexec.bat file so it points to the CD-ROM directory on the hard drive instead of the
floppy drive.

a Tomodify autoexec.bat, type the following at the C: prompt:
a:edit autoexec.bat
b Theline
a:\NWCDEX.EXE /D:mscd001
Must be changed to
c:\NWCDEX.EXE /D:mscd001
¢ Save the changes you just made.
cd d:

11 Run INSTALL.BAT to start the NetWare server installation process. Install the software in a virtual
machine as you would for a physical PC.

12 If the virtual machine has been configured for networking (bridged, host-only, NAT or custom), the
installation program detects a PCI Ethernet adapter and prompts you with a list of possible drivers. At
this point, do not select or load any LAN drivers; press the F3 key to continue installing without a LAN
driver.

NOTE Once the installation has been completed, you can load and bind the appropriate LAN driver.
Selecting or loading a LAN driver during the NetWare 4.2 installation might hang the installation process.

13 Finish the NetWare 4.2 installation by following the on-screen instructions.
Then shut down the server and type exit to return to a MS-DOS prompt.

After you finish the installation, install VMware Tools, which installs and loads the CPU idler program.

VMware Tools

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

In NetWare 4.2 virtual machines, VMware Tools provides CPU idling, sends a heartbeat from the guest
operating system to the host and gives the virtual machine the ability to be gracefully powered on or off.
Installing VMware Tools also installs and loads the CPU idle program. NetWare servers do not idle the CPU
when the operating system is idle. As a result, a virtual machine takes CPU time from the host regardless of
whether the NetWare server software is idle or busy. To prevent unnecessary slowdowns, VMware
recommends that, after you install VMware Tools, you keep the NetWare CPU idle program loaded.
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Solaris 10 Operating System for x86 Platforms

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

VMware products support only the version for x86 platforms. You cannot install the version for SPARC
platforms in a VMware virtual machine.

The easiest method of installing the Solaris 10 Operating System in a virtual machine is to use the standard
Solaris 10 for x86 installation media. The notes below describe an installation using the CD set or DVD. If your
VMware product supports it, you can also install from a PXE server.

Fulfill these requirements before you install Solaris 10 Operating System:

B Create and configure a new virtual machine.

Consider these support and configuration issues for a Solaris 10 Operating System:
B 64-bit Solaris 10 guests support only the e1000 network adapter driver.

B VMware Server or ESX Server:

®  Starting with the Solaris 10 1/06 release, Sun recommends 512MB of memory. 256MB is the minimum
requirement.

®  For the Solaris 10 3/05 release, Sun recommends 256MB of memory. 128MB is the minimum
requirement.

B Before upgrading a virtual machine’s guest operating system to the Solaris 10 1/06 release or later, increase
the virtual machine’s RAM to at least 256MB. See your VMware product documentation for instructions.
For more information see the System Requirements and Recommendations for Solaris 10 Installation, on
the Sun Web site at: http://docs.sun.com/app/docs/doc/817-0544/6mgbagb0v?a=view

Installation Steps

1  Insert the Solaris 10 Operating System for x86 Platforms DVD or the Solaris 10 Software 1 CD in the DVD
or CD-ROM drive.

2 Power on the virtual machine to start installing Solaris 10.
3 Follow the installation steps as you would for a physical machine.

This completes basic installation of the Solaris 10 guest operating system.

VMware Tools (ESX Server 3.x Only)

Be sure to install VMware Tools in your guest operating system. For an overview of VMware Tools and for a
listing of the manuals that contain instructions for installing VMware Tools in your guest, see knowledge base
article 340 at http://kb.vmware.com/kb/340.

NOTE Support for VMware Tools in Solaris 10 prior to Solaris 10 1/06 is experimental.
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Solaris 9 Operating System x86 Platform Edition

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a
VMware virtual machine.

The easiest method of installing the Solaris 9 Operating System in a virtual machine is to use the standard
Solaris x86 Platform Edition Installation CD. The notes below describe an installation using the CD. If your
VMware product supports it, you might also install from a PXE server.

Fulfill these requirements before you install a Solaris 9 Operating System:
B Create and configure a new virtual machine.
Consider these support and configuration issues for a Solaris 9 Operating System:

®  If you want to use a SCSI hard disk in your virtual machine, configure the virtual machine to use the LSI
Logic adapter and use Solaris 9 9/04 or a later release. An LSI Logic driver is included in releases
beginning with Solaris 9 9/04. If you use an earlier release of Solaris 9 and configure the virtual machine
to use a SCSI hard disk, you must get the LSI Logic driver and install it as an install time update. To locate
the driver, go to the LSI Logic download page at www.lIsi.com/support/download_center/ and choose
LSI53C1030 from the Select a Specific Product drop-down list.

Installation Steps
In most respects, you should follow the installation steps as you would for a physical machine.
1  Insert the Solaris 9 x86 Platform Edition installation CD in the CD-ROM drive.

Power on the virtual machine to start installing Solaris 9.

When the Boot Solaris screen appears, Press F4.
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In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings. Press Enter to select it,
and press F2 to continue.

5  Usethe arrow keys to select the property ata-dma—enabled. Press Enter to select it and press F3 to change
the value.

6  Type 1 and press Enter to enable DMA at the Specify Value prompt.
7 Press F2 in the View/Edit Property Settings screen, and press F3 in the Boot Tasks screen.

8  Choose CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the
installation.

To configure the X server

Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity — after all the
software is installed and before configuring the X server.

1 When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the X
server and continue with the installation.

After the software installation completes, the installer prompts you for the root password to configure the
X Server (Windows System Configuration).

Enter the root password. The kdmconfig Mismatch Detected screen appears. Press F2 to configure.
Select the default option, Change Video Device/Monitor, and press F2 to continue.

Press Enter to select 16 color Standard VGA 640x480 (256K) and press F2 to continue.
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Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz). Press Enter and press F2
to continue.
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Do not change the default screen size of 17 inches. Press F2 to continue.
Do not change the default option 640x480. Press F2 in the Virtual Screen Resolution Selection screen.

Do not change the default of No changes needed — Test/Save and Exit. Press F2 to continue.
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Press F4 to bypass the Windows System Configuration tests.
10 Follow the prompts to complete the installation.

This completes the basic installation of the Solaris 9 guest operating system and KDM X server.

VMware Tools

There is no version of VMware Tools that supports Solaris 9.
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Solaris 8 Operating System x86 Platform Edition

Be sure to read “General Installation Instructions for All VMware Products” on page 14 and this section before
installing this operating system.

VMware products support only the x86 Platform Edition. You cannot install the SPARC Platform Edition in a
VMware virtual machine.

The easiest method of installing the Solaris 8 x86 in a virtual machine is to use the standard Solaris 8 x86
Platform Edition Installation CD. If your VMware product supports it, you might also install from a PXE
server.

Fulfill these requirements before you install a Solaris 8 Operating System:
B Create and configure a new virtual machine.
Consider these support and configuration issues for a Solaris 8 Operating System:

®  The Solaris 8 installation CD does not include the Solaris 8 SCSI (LSI/LSISAS) drivers. If you select
LSI/LSISAS drivers when installing the guest on the virtual machine, it will not detect the SCSI hard disk
unless you install the drivers during the Solaris 8 installation. As a result, you need to create an Install
Time Update (ITU) driver disk.

®  If you plan to use a SCSI hard drive, see “Adding a SCSI Driver” on page 160.

®m  If you selected an IDE controller, begin installing Solaris 8 by following the “Installation Steps” on
page 159.

Installation Steps
In most respects, you should follow the installation steps as you would for a physical machine.
1  Insert the Solaris 8 x86 Platform Edition installation CD in the CD-ROM drive.

Power on the virtual machine to start installing Solaris 8.

When the Boot Solaris screen appears, Press F4.
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In the Boot Tasks screen, use the arrow keys to select View/Edit Property Settings. Press Enter to select it,
and press F2 to continue.

5  Usethe arrow keys to select the property ata-dma—enabled. Press Enter to select it and press F3 to change
the value.

6  Type 1 and press Enter to enable DMA at the Specify Value prompt.
7 Press F2 in the View/Edit Property Settings screen, and press F3 in the Boot Tasks screen.

8  Choose CD in the Boot Solaris screen if you are installing from the CD-ROM set and continue with the
installation.

To configure the X server

Skip configuring the KDM X server at the first two opportunities. Wait for the third opportunity — after all the
software is installed and before configuring the X server.

1 When the kdmconfig - Introduction screen appears during installation, press F4 to skip configuring the X
server and continue with the installation.

After the software installation completes, the installer prompts you for the root password to configure the
X Server (Windows System Configuration).

2 Enter the root password. The kdmconfig Mismatch Detected screen appears. Press F2 to configure.
3 Select the default option, Change Video Device/Monitor, and press F2 to continue.

4  Press Enter to select 16 color Standard VGA 640x480 (256K) and press F2 to continue.
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5  Use the arrow keys to select Multifrequency 100KHz (up to 1600x1200 @ 80Hz). Press Enter and press F2
to continue.

Do not change the default screen size of 17 inches. Press F2 to continue.
Do not change the default option 640x480. Press F2 in the Virtual Screen Resolution Selection screen.

Do not change the default of No changes needed — Test/Save and Exit. Press F2 to continue.
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Press F4 to bypass the Windows System Configuration tests.
10 Follow the prompts to complete the installation.

This completes the basic installation of the Solaris 8 guest operating system and KDM X server.

Adding a SCSI Driver

To add a SCSI drive, first create a driver disk with the Solaris 8 drivers. During installation when you install
the drivers, the drivers detect the SCSI hard drive.

Download SCSI drivers for Solaris 8 from the LSI Web site:
http://www.lsi.com/DistributionSystem/AssetDocument/itmpt_x86_5.07.04.zip

Creating an ITU Driver Disk Using Solaris

Use the existing dd image itmpt-x86-50704-itu—s9.dd file in the zip file to create the driver disk.

Type the following command to create the driver disk:

dd if=itmpt-x86-50704-itu-s9.dd of=/vol/dev/aliases/floppy® bs=32768

NOTE If you want to use Windows to create the disk, refer to the instructions in itmpt_x86_5.07.04.txtin
the zip file.

Detecting the SCSI Hard Drive
These instructions apply to both SCSI and LSI/LSI SAS.

1  When you begin the installation, press F4 in the Solaris Device Configuration Assistant screen to add the
drivers.

2 Insert the ITU disk (connect the Floppy drive to A: in the virtual machine) and press F2 to continue.
The disk loads the software on the virtual machine.
3 In the Continue Supplement Driver Installation screen, first disconnect the disk and then press F4.

4  Press F2 to continue the installation in the Identified Device Drivers screen. Then follow the rest of the
installation steps from Step 3 in “Installation Steps” on page 159.

VMware Tools

There is no version of VMware Tools that supports Solaris 8.
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